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Overview 

The PolyView2000™ Spectral Processing application, in 
conjunction with the Varian Star Workstation, provides post-run 
analysis of data from the 330 and the 9065 Diode Array 
Detectors. Unlike other chromatographic UV absorbance 
detectors that provide data in two domains, time and 
absorbance, the Diode Array Detectors yields data in the 
additional domain of wavelength. 

 

Complete 
Spectral 
Data 

Domains of 330 Diode Array Data 

While the data from a diode array detector is obviously more 
complex than a typical UV absorbance detector, this complexity 
can provide the chromatographer with considerably more 
information as well, when it is presented in an easily 
understandable form. 
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The PolyView2000 application is designed to handle this more 
complex data structure, enabling the user to extract a spectrum 
from any point in time within a chromatogram, or to generate an 
absorbance chromatogram at any wavelength (or set of 
wavelengths) within the wavelength range of the Diode Array 
detector. In this way, PolyView2000 can provide the user with 
qualitative information regarding an eluting compound. When 
PolyView2000 is used to generate an absorbance 
chromatogram, the Diode Array detector functions in much the 
same way as any other UV absorbance detector, yielding a 
concentration profile that changes with time. When 
PolyView2000 is used to examine UV absorbance spectra, this 
information, in conjunction with the retention time of the eluting 
compound, provides qualitative information that can be used to 
identify the compound of interest. In addition, the Multi-
Component Analysis process (MCA) combines accurate 
quantitative analysis and purity evaluation, even in cases of 
coelution. 

PolyView2000 Functions 
The principal functions of the PolyView2000 Spectral Processing 
application are described in the following paragraphs. 

Plotting a Chromatogram 
The PolyView2000 application can provide plots of absorbance 
as a function of time at any of the available wavelengths within 
the range of the Diode Array Detector. While the absorbance 
chromatogram is the mainstay of chromatographic analysis, and 
as such, is often the starting point within the PolyView2000 
application, UV absorbance chromatograms are not the only 
plots provided within PolyView2000. Additional treatments of the 
330 data are also available, including plots of Purity 
Parameter™, absorbance ratios, wavelength maxima, and 
absorbance maxima. Just as an absorbance chromatogram 
provides absorbance as a function of time, these other 
parameters are also generated as a function of time. The results 
are a series of time dependent profiles that provide qualitative 
information on the spectral characteristics of eluting peaks. All 
chromatogram plots can be obtained both interactively and under 
automation. 

2 03-914774-00:4 



OVERVIEW 
POLYVIEW2000 FUNCTIONS 

Examining and Analyzing Spectra 
As mentioned earlier, through the PolyView2000 application, all 
of the spectra that constitute a raw data file are available for 
examination and analysis. Spectra can be viewed individually, or 
up to seven spectra can be overlaid and viewed at the same 
time. This spectral plot can be expanded to visually show 
detailed information about spectra. In addition, these spectra can 
be operated on arithmetically, enabling you to create a 
composite spectrum that is the sum or difference of several 
spectra. Most spectral functions are performed interactively, but 
reports comparing sample spectra to reference spectra are 
produced as part of the library search and MCA automated 
commands. 

Building, Editing, and Searching Spectral 
Libraries 
A particularly useful feature of PolyView2000 is the ability to 
create and maintain libraries of spectra. Within a spectral library, 
you can archive those spectra that are relevant to a particular 
chromatographic application. PolyView2000 can then provide 
ordered searches of these libraries, comparing a spectrum of 
interest within a chromatogram to the spectra stored within one 
or more spectral libraries. Library building and editing are 
interactive tasks. Library searching can be performed 
interactively or under automation. 

Determining the Purity of a Chromatographic 
Peak 
Co-elution is often a problem with samples composed of 
structurally similar constituents. PolyView2000 provides several 
means of determining the purity of a chromatographic peak by 
displaying the spectral characteristics across the width of the 
peak. As an example, the Purity Parameter of a UV spectrum 
uniquely distinguishes it from other similar spectra. By plotting 
the Purity Parameter as a function of time, slight differences in 
the UV spectra across a peak can be determined, indicating the 
presence of impurities. Similarly, absorbance ratio and 
wavelength maxima plots can be used to indicate spectral 
dissimilarities across the width of a peak.  
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Purity Evaluation by Multicomponent Analysis 
Multicomponent Analysis also provides a powerful tool to assess 
the spectral homogeneity of a peak or the presence of 
unexpected impurities. All purity features are available both 
interactively and under automation. 

Preparing Reports of Diode Array Data 
An important function of PolyView2000 is the ability to generate 
reports that contain the results of the data analyses. These 
reports are available in a variety of formats and cover most of the 
operations that are possible with PolyView2000. You can 
generate reports while working at the Star Workstation itself 
(interactive reports) or at the end of a run and some time later in 
an automated fashion (non-interactive reports). 

Recalculating the Peak Sense Events in a Diode 
Array Raw Data File 
Associated with every UV absorbance chromatogram obtained 
with the Diode Array detector is a series of peak sense events. 
These events mark important points within a chromatogram, and 
include peak start, peak end, peak apex and peak upslope and 
downslope. At times, the peak sense events that are calculated 
and set at the time of acquisition of a diode array data file may 
need to be redetermined. PolyView2000, in conjunction with the 
Method Builder application of the Star Workstation, provides the 
ability to recalculate these peak sense events. 

Quantitative Analysis by Multicomponent 
Analysis 
By integrating a group of fused peaks at each wavelength, one 
obtains an Area Spectrum. This Area Spectrum is the baseline-
corrected spectrum of an elution fraction. If the spectra of all 
components are known, the Area Spectrum can be decomposed 
by a simple mathematical process known as Multicomponent 
Analysis. This process is routinely used in spectrophotometers. 
In PolyView2000, this process is used to obtain precise 
quantitative results from overlapping peaks. 
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OVERVIEW 
POLYVIEW2000 WINDOWS 

Creation of Reduced Data Files 
PolyView2000 can reduce a data file to a few channels of data 
corresponding to time-programmed wavelengths or wavelength 
ranges, while preserving full spectra for the events detected by 
peak sensing. These channels can also be created while 
preserving all spectral data. These files can be created both 
interactively and under automation. 

PolyView2000 Windows 
The PolyView2000 Spectral Processing application is organized 
into several distinct child windows within the PolyView2000 main 
application window. These include the Plot window, Spectra 
Manager window, Library Manager window, Reports window, 
Peak Sense window, and the MCA window. The following  
illustration shows the organization of the PolyView2000 windows 
and the transfer of data between the windows. Multiple copies of 
several of the windows are available as indicated. 
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Organization of the PolyView2000 Windows 
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The three windows used most in PolyView2000 functions are the 
Plot, Spectra Manager, and Library Manager Windows. When 
PolyView2000 is first started, the screen is split between these 
three windows. 

You will find that many of the data analyses performed using 
PolyView2000 requires only these three windows and you will 
not need to alter the screen configuration or create additional 
windows. Of course, if your work requires the use of additional 
windows, they are easily created and the screen configuration 
can be easily altered. Following is a brief description of the six 
PolyView2000 windows. For more detail on the functions 
available in each and the operation of On-Line Help, refer to the 
operation section. 

 

 
PolyView2000 Configuration Upon Start-Up 
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OVERVIEW 
POLYVIEW2000 WINDOWS 

Plot Window 
The Plot window is used to plot chromatograms from diode array 
raw data files (.RUN files). The plots can display the absorbance, 
Purity Parameter, absorbance ratio, absorbance maxima or 
wavelength maxima, each as a function of run time. Once 
displayed, regions of the plot can be enlarged (zoomed) and a 
variety of spectral correction methods can be selected. Only one 
chromatogram at a time can be displayed in the window. 
However, several plot windows can be displayed on the screen 
at the same time for comparison of different .RUN files or to 
compare different plot conditions on the same .RUN file. 
Additional features in the plot window include the ability to 
display peak events (peak start, peak end, apex, etc.) and to 
transfer selected spectra from the displayed raw data file to the 
Spectra Manager window. 

 
The Plot Window 
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Spectra Manager Window 
The primary function of the Spectra Manager window is the 
display and analysis of UV spectra from selected points in a 
chromatogram. A single spectrum can be displayed or up to 
seven spectra can be overlaid. Information about the spectra, 
such as compound name, operator, and method name, can be 
added or edited in this window. This information becomes a part 
of that particular spectrum record and is transferred with it 
between the various PolyView2000 windows.  

 
The Spectra Manager Window 

A number of data analysis functions can be performed in the 
Spectra Manager window such as the calculation of Purity 
Parameters, the determination of their statistics, and the 
arithmetic combination of spectra. Also, the wavelength range 
over which the Purity Parameter is calculated can be optimized. 
Several different reports of the spectra and the spectral analyses 
can be prepared and printed directly from the Spectra Manager 
window. From this window, spectra can be transferred to the 
Library Manager window for use in spectral library functions. 
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OVERVIEW 
POLYVIEW2000 WINDOWS 

Library Manager Window 
A variety of spectral library functions are performed within the 
Library Manager window. These include building and editing 
libraries, conducting library searches, and preparing reports of 
the search results. Any spectrum transferred into the Library 
Manager window from the Spectra Manager is held in a 
spectrum register. The Library Manager window has the ability to 
hold only one spectrum. Information about the spectrum (name, 
operator, etc.) can be added to this spectrum in the same 
manner as it was in the Spectra Manager window. In addition, 
the Library Manager provides for the management of disk 
libraries of up to 120 spectra each. Library management 
functions include adding, editing, and deleting spectra in 
libraries. Additionally, key word searches of the contents of a 
library can be made to quickly locate a selected spectrum. In 
addition to the library management functions, library searches 
are performed in the Library Manager window. To conduct a 
search, a spectrum is transferred from the Spectra Manager 
window into the Library Manager window. One or several disk 
libraries are specified and the search is conducted based on a 
number of selectable criteria including Purity Parameter, 
retention time, and wavelength. The search results are ordered 
according to the similarity between the target spectrum and the 
match spectrum from the library. Reports can then be printed to 
document the results of the library search. 
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The Library Manager Window 

Reports Window 
A wide variety of printed reports can be prepared in 
PolyView2000. Most operations within PolyView2000 windows 
can be documented through an “interactive” report obtained 
either by selecting Print... from the File menu or by selecting the 
Print pushbutton appearing in many of the dialog boxes. This is 
just one way to obtain a printed report. Reports can also be 
prepared in an automated, unattended fashion. In PolyView2000, 
a separate window, the Reports window, is used to prepare and 
manage these reports. The Reports window is not activated at 
the time of start-up and must be created using the New Reports 
Window command item under the Window menu. A variety of 
different reports can be prepared in this window including 
chromatograms, library searches, peak purity surveys, and 
tables of data characterizing the peak events in a data file. The 
contents of a report are first specified in the Method Builder 
application and then prepared in the Reports window. Once 
prepared, the report is saved as a disk file. It can then be loaded 
in the Report Window, viewed on the screen, edited, printed, or 
exported in a variety of formats to other windows applications. 
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OVERVIEW 
POLYVIEW2000 WINDOWS 

 
The Reports Window 

Peak Sense Window 
A number of functions within PolyView2000 require peak 
detection to determine the various peak events (peak start, peak 
end, inflection points, and apices). For instance, to provide 
efficient spectral correction to account for mobile phase 
absorbance, the peak start and ending points must be accurately 
determined. This ensures that the spectra obtained for an eluting 
peak accurately reflect the compound of interest, free from 
background interference. At the time of data collection, 
PolyView2000 peak sensing is automatically performed on diode 
array files, provided a PolyView2000 section is included in the 
Workstation method file (.MTH) under which the data is 
collected. However, if no PolyView2000 section was included or 
if the peak detection was not accurate (as indicated by 
misplaced peak events or baseline), then peak sensing may 
need to be repeated.  

PolyView2000TM 11 



The Peak Sense window is used to perform a peak sense 
recalculation on a raw data file. Like the Reports window, the 
Peak Sense window must be created using the New Peak 
Sense Window menu item under the Windows menu. In the 
Peak Sense window, the absorbance chromatogram is displayed 
at the wavelength used for peak sensing. To perform peak 
sensing, the method to be used (wavelength, peak width, etc.) is 
specified in the Method Builder application and then used in the 
Peak Sense window. Additional features include the ability to 
view and edit the noise data acquired by the Workstation during 
the diode array monitor period. The noise data is used in 
conjunction with the S/N ratio parameter to detect peaks, and 
editing of this data may be required in cases where there was 
excessive detector noise during the monitor period. 

 
The Peak Sense Window 
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OVERVIEW 
POLYVIEW2000 WINDOWS 

MCA Window 
The Multicomponent Analysis window contains all the functions 
required to perform MCA Quantitative Analysis and Purity 
Evaluation. The MCA window is composed of 3 areas. The 
bottom half displays a Chromatogram at a user selectable 
wavelength, which is used to select the integration limits. The 
upper right quarter contains 6 push buttons that implement the 
main commands, and the upper left quarter shows the spectrum 
of the integrated chromatogram region. 

 
The MCA Window 
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PolyView2000 and Other Star Workstation Applications 
The PolyView2000 application software is integrated into the 
Star Workstation to enable the Star Workstation to conduct 
automated tasks that include PolyView2000 functions. For 
instance, at the end of a chromatographic run, the Star 
Workstation can automatically conduct PolyView2000 peak 
sensing on the .RUN data file and prepare selected 
PolyView2000 reports, all without your actually having to start 
the PolyView2000 application. 

Upon installation, a PolyView2000 Icon is added to the Star 
Workstation’s Star Tool Bar. PolyView2000 interacts with two 
other Star Workstation applications, Method Builder and System 
Control/Automation. The .MTH file is used to specify the peak 
sensing conditions (wavelength, peak width, etc.) or the type of 
reports needed. Method Builder is used to build and manage the 
.MTH files that are used to perform these functions. In 
PolyView2000, the Method Builder application can be accessed 
directly, without going through the Star Tool Bar. When accessed 
in this manner, after the method editing session is completed 
and the Method Builder application is closed, control is returned 
to PolyView2000, right where you left off.  

NOTE: See the Data Acquisition with LC Control Operation Manual for more 
details on the functions and operation of the Method Builder application. 

The other Star Workstation application that interacts with 
PolyView2000 is System Control/Automation. However, the 
interaction is not readily apparent to the user, as it involves 
internal processing within the Star Workstation via the AutoLink 
protocol. When a diode array detector is operating under the 
control of the System Control/Automation application, post-run 
PolyView2000 processing and reporting is performed on any 
diode array file based on the PolyView2000 section in the active 
method. If no PolyView2000 section exists in the method, default 
peak sensing conditions are used, and no reports are created. 
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OVERVIEW 
POLYVIEW2000 AND OTHER STAR WORKSTATION APPLICATIONS 

The results of the peak sensing and/or reporting performed 
under System Control/ Automation are exactly the same as if 
these functions had been performed interactively in 
PolyView2000. System Control/Automation is also used if a 
series of .RUN files need to have peak sensing or reporting 
repeated on them. In this case, the recalculation capability of 
System Control/Automation is used to conduct PolyView2000 
peak sensing or reporting on a series of .RUN files. 

NOTE: See the Data Acquisition with LC Control Operation Manual for more 
details on the operation of the System Control/Automation application. 
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Operation 

The functions and operation of PolyView2000 are described in 
this section. PolyView2000 is a very powerful software program 
and often there are several different ways to accomplish the 
same task. It is not the purpose of this section to fully describe 
every operation available within PolyView2000. Rather, the 
primary functions will be described along with a series of short 
Examples to assist you in getting started using PolyView2000; in 
particular, learn to use the On-Line Help which contains both 
Reference and Procedural information. This may help you to 
accomplish a particular function in a different way than that 
described in the Tutorials. Use the commands that are best 
suited to your particular needs or application. The primary 
PolyView2000 functions covered in this section are: 

• Configuring PolyView2000 Windows 
• Plotting A Chromatogram 
• Examining Spectra from a Chromatogram 
• Performing Library Functions 
• Reporting Data 
• Determining Peak Purity 
• Purity Parameter 
• Performing Peak Sensing 
• Automating PolyView2000 Operations 
• Using On-Line Help 
• Quantitative Analysis by MCA 
• Purity Evaluation by MCA 
• Creating Workstation Channels 
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Following the description of each of these functions, one or more 
Tutorials are presented to help you get started. Read the 
functional description section, work through the Tutorials, and 
then refer to the section or On-Line Help if further information is 
needed on a particular window or menu item. 

Configuring PolyView2000 Windows 
PolyView2000 operates under Microsoft Windows Multiple 
Document Interface (MDI). The MDI tracks and reflects changes 
in the menus associated with each child window within a main 
application window. The menu at the top of the main application 
window changes as the nature of the active child window 
changes. For example, within the PolyView2000 main application 
window, if you move from a child window that is used to manage 
spectra, to a child window used to manage libraries, spectrum-
specific menus will be replaced with library-specific menus. 
When a number of child windows are present in the main 
application window, a child window is made the active window 
by moving the mouse cursor to that window and clicking on its 
title bar. The title bar changes color (or contrast) to indicate that 
it is now the active window. The menu names and items 
reflecting the functions and operation of the active child window 
are then displayed within the menu bar of the main application 
window at the top of the screen. Organization of the child 
windows within the main application window can easily be 
accomplished using the commands under the Window menu. 
Individual windows can be created, hidden from view, recalled, 
and arranged in a variety of different configurations. In addition, 
all of the window sizing controls are available as they are in most 
Windows applications. 

NOTE: If you require further explanation of the operation of the MDI within 
Windows, or additional detail on Microsoft Windows itself, refer to the 
Star Workstation Operation Manual, or the Microsoft Windows User's 
Guide. 
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TUTORIAL: CONFIGURING POLYVIEW2000 WINDOWS 

Tutorial: Configuring PolyView2000 Windows 
On the Star Tool Bar, double-click on the PolyView2000 icon. 
The application opens with the screen split between the Spectra 
Manager, Library Manager and Plot windows with the focus on 
the Plot Window. 

 
PolyView2000 Configuration Upon Start-Up 

All of the windows can be sized using the border controls and the 
sizing control in the upper right corner of each child. In addition, 
the main application window can be sized using its borders and 
controls when it is not maximized. The one restriction is that all 
the child windows must always remain within the confines of the 
main application window.  Practice some of these window sizing 
functions and make the screen appear as shown below. 
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PolyView2000 Window Configured to Increase  

Spectra Manager Area 

The number and type of windows displayed within the 
PolyView2000 main application window are controlled using the 
Window menu. This menu is visible and available at all times.  

• Create a Reports window by selecting New Reports 
Window under the Window menu.  

• Repeat this process, but this time select a Peak Sense 
window. These windows, like all the others, can be moved 
and sized to any configuration desired using standard 
Windows methods. But, don't do that now. There is a much 
easier way as you will see in a minute. 

Any of the currently active windows within PolyView2000 can be 
instantly accessed and displayed full screen.  

• Drop down the Window menu and note that the five 
PolyView2000 windows are listed at the bottom of the menu.  
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Windows Menu Listing the Currently Active Windows 

• Click on Spectra Manager in the Window menu and note that 
this window is brought forward. 

• You may maximize any window to the full size of the 
PolyView2000 window simply by double-clicking on the title 
bar of the window you wish to maximize. Try this now, to 
maximize the Spectra Manager window. 

• Any of the open windows can be accessed instantly in this 
manner. Multiple copies of the Plot, Peak Sense, and 
Reports windows can be active simultaneously and all of 
these multiple copies will be listed under the Window menu. 
This allows you to rapidly select from a number of 
chromatograms that may be currently active within 
PolyView2000. 

A rapid method is provided that allows you to view all the 
currently active windows.  

• Drop down the Window menu and select “Arrange All”. The 
screen is split between all the windows under the Window 
menu. 
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Screen Split Among Five PolyView2000 Windows 

• Individual windows can be hidden from view also. Click on 
the title bar of the Library Manager window to make it the 
active window, drop down the Window menu and select 
Hide. Notice that the Library Manager is hidden from view, 
but it is not removed from the list of active windows (i.e., it 
still appears in the list under the Window menu). 
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PolyView2000 with Library Manager Hidden from View 

• Now, the remaining windows can be organized. Select 
“Arrange Visible” under the Window menu and note that the 
screen is partitioned between the four remaining visible 
windows. 
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PolyView2000 Screen Split Between the Four Visible Windows 

• In this way the screen can be rapidly configured to meet the 
needs of the PolyView2000 function you are performing. 

• Also try “Arrange Plots”. 

Except for the Spectra Manager and Library Manager windows, 
the individual child windows within PolyView2000 can be closed. 

• Drop down the Window menu and select Arrange All. 

• Close the Reports, Plot, and Peak Sense windows by 
double-clicking in their Control Menu boxes. Note that the 
Control Menu box does not appear in a window's title bar 
until that window has been selected as the active window by 
clicking within it. You may go ahead and double-click where 
the Control Menu box would be and the window will be both 
selected and closed at the same time. 

• Drop down the Window menu and note that these three 
windows are no longer listed. It is important to remember the 
difference between a window that is merely hidden and one 
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that is closed. All data in a window is lost when it is closed, 
but simply hiding the window does not destroy the data. 

• Close PolyView2000 by double-clicking on the Control Menu 
box in the main application window. 

Plotting a Chromatogram 
With the PolyView2000 application, raw data files transmitted 
from the Diode Array detector and collected at the Star 
Workstation can be plotted, examined on the display screen of 
the Star Workstation, and then printed out. The Plot Window, 
within the PolyView2000 main application window, is used to 
perform these functions. There are a variety of different plot 
types available in PolyView2000, each expressing the raw data 
in a different format. See On-Line Help (Help:Plot Manager) for 
an explanation of the different types of plots available and their 
uses. In the following Tutorial, the basics of chromatogram 
plotting are covered. In subsequent Tutorials, some of the more 
functional aspects of the chromatogram plots, such as their use 
in the determination of peak purity, will be addressed. 

NOTE: It is not the purpose of this Tutorial to cover every possible function in the 
Plot window. However, the basic functions are covered. For information 
on those functions not covered, such as those under the Peak Events 
menu, refer to On-Line Help. 

 In the following Tutorial, some of the files in the EXAMPLES directory will 
be modified and/or created. Prior to performing this Tutorial, you should 
ensure that you are working with original copies of the data files called 
for. If you are not sure whether these files have been modified by 
previous use of the Tutorial, reinstall the PolyView2000 software from the 
CD using your serial number.  
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Tutorial: Plotting a Chromatogram 
On the Star Tool Bar, double-click on the PolyView2000 Spectral 
Processing icon. The application starts with the screen split 
between the Spectra Manager, Library Manager and Plot 
windows with the focus on the latter. To plot a chromatogram: 

• Drop down the File menu and select Open File... . A dialog 
box is displayed that lists directories and files with the 
extension .RUN. Press the “Help” button for more 
information on the operation of file selection dialog boxes. 

 
File Selection Dialog Box 

• Select the EXAMPLES directory from the list and note that 
the Path field should display: C:\Star\Examples. 

• Click once on a .RUN file. Try BASECORR.RUN. Notice that 
the fields at the bottom of the screen fill with information 
about this file. The Status field indicates that a valid file has 
been selected. If you had selected a non-diode array file, an 
error message in red would have been displayed instead. 
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• Click on OK to accept this file. The absorbance 
chromatogram at 253.6 nm is plotted in the Plot window at 
the bottom of the screen. The plot is autoscaled on the Y-
axis and is plotted from time 0.0 to the end of the run 

• Use the Select Plot Parameters command in the Plot menu 
to plot the absorbance at 210 nm instead. If the plot goes off 
scale, double click to the left of the absorbance scale when a 
double headed arrow appears. 

 
BASECORR.RUN in the Plot Window 

Many PolyView2000 functions can be performed with the window 
in this configuration, but there are many ways to alter the viewing 
of the chromatogram. Maximize the Plot window (click on the box 
with a solid line above it in the upper right hand corner of  the 
Plot window). This enlarges the chromatogram to full screen. 
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Full Chromatogram 

More detail in the chromatogram can be seen by utilizing the 
zoom functions. Zooming in PolyView2000 is accomplished by 
the drag method, the same as in the Interactive Graphics 
application. 

• Using the mouse, position the cursor below the baseline just 
to the left of the peak at 7.2 minutes. Press the left mouse 
button and hold it down as you drag the mouse diagonally 
toward the upper-right portion of the peak. The portion to be 
zoomed will appear in reverse video and when the mouse 
button is released, the plot will be zoomed. 
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Plot Window Zoomed in on a Peak 

• The plot can be zoomed again to observe even more detail. 
Try zooming the top portion of the peak. 

• Pressing the Escape (ESC) key during the drag process 
aborts the zoom process. 

To restore the scaling in effect prior to the latest zoom, drop 
down the View menu and select Previous. The plot is returned to 
the full peak. Selecting Previous again restores the zoomed top 
portion of the peak and thus functions as a toggle to switch 
between two zoom selections. 

The full time range can be restored by positioning the cursor just 
below the time axis and double-clicking with the left mouse 
button. Note that the cursor changes to a double-headed arrow 
indicating that the plot will be restored to its full X-axis scaling. 
Similarly, the full Y-axis scaling can be restored by double-
clicking the mouse with the cursor positioned to the left of the Y-
axis. Both can be restored simultaneously by double-clicking in 
the lower left corner. Try these functions now and restore the 
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scaling to its original setting when the chromatogram was first 
displayed. 

NOTE: Chromatogram zooming can also be controlled using the commands under 
the View menu. See On-Line Help (Help:Commands) for an explanation of 
these menu items.  

To change the plot configuration (type, wavelength, etc.), drop 
down the Plot menu and click on the Select Plot Parameters 
menu item. This displays a dialog box that is used to specify the 
type of plot and features. The X and Y scales can be set here, 
the peak events can be turned on and off, and the wavelength 
range can be selected. Many of these features will be covered in 
future Tutorials.  

 
The Select Plot Parameters Dialog Box 

For this exercise: 

• Change the events list box in the lower right corner to Draw 
Apex Events. 

• Set the wavelength range to 220-366 nm using the 
Wavelength Range scroll boxes by either scrolling to the 
proper number or typing the number. Type the left hand 
lower wavelength first and then the right hand higher 
wavelength.  
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NOTES: For many PolyView2000 functions where either a single wavelength or a 
wavelength range can be set, setting the right hand scroll box with cause 
both boxes to have the same wavelength.  Setting the right hand scroll 
box will not effect the left hand box.  Therefore, to set a single 
wavelength you only need to set the right hand scroll box. 

 Checking the “Save as default parameters dialog” check box will save 
this plot type and condition (except time and scale ranges) and make 
them the default conditions for any plot windows created later, even in 
other sessions of PolyView2000. Do not check it at this time. 

• Click on the OK pushbutton. The chromatogram will be 
plotted using the average absorbance in the range of 
220.00-366.00 nm with only peak apex events drawn. Notice 
that the original absorbance scaling was maintained.  

To autoscale, simply double-click in the left margin of the Plot 
window. To prepare for the next step, zoom in on the peak at 
19.3 minutes. 

 
BASECORR.RUN Displayed at 220.00-366.00 
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When spectra are extracted from a chromatogram, 
PolyView2000 automatically corrects them for background 
absorbance. Several different types of correction are available 
and are set in the Correction menu. 

The default is baseline but other types are available, including 
the selection of one or more spectra in the file to use as a 
reference to which all others are corrected. The current 
correction method is indicated below the time axis. Let's try that 
function now: 

• Drop down the Correction menu and select Reference. A 
dialog box appears that prompts you to select the reference 
spectra. 

• Move the cursor to any point of the chromatogram left of the 
peak at 19.3 minutes, and press the left mouse button once. 
A vertical line is drawn to indicate the reference spectrum. 
Define another reference spectrum right of the peak, then 
press OK to indicate that you are done defining the 
reference spectra. The baseline is redrawn to indicate the 
change. The correction is interpolated between reference 
spectra, and uses the outermost reference spectra to correct 
spectra extracted from the corresponding regions. The 
correction method can easily be changed to a different mode 
by making a different selection in the Correction menu. 
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BASECORR.RUN with Reference Correction 

• Make the correction method Peak Start and note that the 
red lines under each peak originate from the peak start event 
and project horizontally.  

The effect of the baseline correction mode on extracted spectra 
will be demonstrated in the next Tutorial. 

Associated with each .RUN file is information that describes the 
conditions under which it was collected (date, time, etc.). Within 
PolyView2000, some of this information can be viewed and 
edited. 

• Under the File menu, select Edit File Information. A dialog 
box will appear that allows you to edit selected fields. Fields 
that can be edited are enclosed in boxes and they are edited 
by standard Windows techniques. 
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The Edit File Information Dialog Box 

• Type your name in the Operator field and add any comments 
into the Notepad. 

• Click on OK to write the new information into the disk file for 
BASECORR.RUN. 

To print a chromatogram from PolyView2000, select the Print 
Plot command under the File menu and the chromatogram will 
be printed on the current Star Workstation printer. See Appendix 
A for an example of this interactive plot report.  

Close PolyView2000 by double-clicking on the Control Menu box 
in the main application window. 
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Examining Spectra from a Chromatogram 
The primary advantage of a diode array detector such as 330 is 
the availability of spectra at all points in the chromatogram. 
These spectra provide valuable qualitative data on the nature of 
an eluting peak. Using the PolyView2000 advanced baseline 
correction routines, the spectra extracted from a chromatogram 
are free of errors due to any background solvent absorbance and 
reflect only the spectra of the eluting compound. Within 
PolyView2000, the primary spectra handling utilities are provided 
in the Spectra Manager window. This window provides a 
temporary storage location for up to seven UV spectra. The 
spectra that are held in these spectrum registers are available for 
a variety of spectral processing and reporting functions. In 
addition, the window serves as a temporary storage location for 
spectra before they are transferred to the Library Manager 
window for inclusion in a disk library or as the target of a library 
search. 

The spectral processing functions available include the 
calculation of Purity Parameter statistics, the optimization of 
Purity Parameter spectral ranges and the arithmetic combination 
of spectra. Details on these functions can be found in On-Line 
Help (Help:Commands:Spectrum). 

The following two Tutorials cover the Spectra Manager functions. 
As you are going through these Tutorials, keep in mind that there 
may be more than one way to perform many of these functions. 
An attempt has been made to present the most straightforward 
method. With experience, you may find that an alternate way of 
accomplishing the function may be more suited to your 
application. Feel free to explore these alternate command paths. 

PolyView2000TM 35 



Tutorial: Spectral Plots 
On the Star Workstation Star Tool Bar, double-click on the 
PolyView2000 Spectral Processing icon. The application starts 
with the screen split between the Spectra Manager, Library 
Manager and Plot windows with the focus on the latter. 

Configure the screen to display the Spectra Manager window 
and the Plot window. 

 
PolyView2000 Screen without Library Manager 

Plot out the data file BASECORR.RUN from the EXAMPLES 
directory in the Plot window at 210 nm with Apex and Inflections 
events displayed (see the Tutorial: Plotting a Chromatogram). 

Spectra are extracted from the chromatogram and transferred to 
the Spectra Manager window by clicking the mouse at the 
desired point in the chromatogram. Try that now: 
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• Zoom in on the peak at 7.3 minutes and extract three 
spectra at the apex and the front and back inflection points. 
Notice that each time you click on the chromatogram, a 
spectrum for that peak appears in the Spectra Manager 
window and the point in the chromatogram where the 
spectrum was extracted is marked with a corresponding 
colored line. Move the cursor to the Spectra Manager display 
and zoom on the spectra until your screen should look 
similar to the figure below. 

 
Overlaid Spectra, and Markers on the Chromatogram 

The graphics display in the Spectra Manager window is 
controlled through a set of commands in the Display menu. Try 
some of these now: 

• First, click on the title bar of the Spectra Manager window to 
make it the active window. 
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Normalized Spectra 

• Drop down the Display menu and select Normalized. Notice 
that the three spectra are now normalized over their entire 
wavelength range. You can compare them over a limited 
range by zooming on the range as shown. This allows you to 
compare their shapes. 

• Drop down the Display menu again and select Single Plots. 
In this mode, only one spectrum is displayed at the time.  
Use the numbered colored buttons at the bottom of the 
Spectrum Manager Window to choose which spectrum you 
want to display.  

The wavelength scale for the Spectra Manager window is 
variable depending on the wavelength of data that was collected.  
For the 9065, this is 190 to 367 nm (the limits of the 9065 diode 
array detector). For the 330 Diode array detector, this is the 
range over which the data was taken.  If spectra from different 
diode array runs are compared where the range of wavelengths 
for the data is different, the widest range needed to encompass 
all of the data is used.  When the spectra is zoomed, the entire 
screen is considered the working range. The wavelength flags 
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that appear at the top of the Spectra Manager display indicate 
this range. This is the range considered when normalizing plots 
and in performing some of the math functions addressed in the 
next Tutorial. The range can be quickly altered by zooming in the 
Plot window. Try that now: 

• Zoom (using the click and drag method) the Spectra 
Manager window in the region between 250 and 300 nm. 

The seven numbered boxes at the bottom of the Spectra 
Manager window screen represent the seven spectra storage 
registers in this window. When a spectrum is in one of the 
spectrum registers, a colored rectangle appears in the box. A 
filled rectangle means that the spectrum is currently displayed, 
while an empty rectangle indicates that the register position 
contains a spectrum but it is not currently displayed. You can 
turn on and turn off which spectra are displayed by clicking in the 
numbered boxes containing spectra. 

Try that now. Point to the second box and click the mouse. 
Notice that the first spectrum was turned off, since Single Plots 
was selected. If Multiple Plots had been currently selected, this 
action would simply turn on and off that particular spectrum. 
Double-clicking on a particular box calls up that spectrum for 
editing. This feature will be covered in the Tutorial:Building and 
Editing a Library. 

Spectra can be removed from the Spectra Manager window 
using the controls under the Spectrum menu. 

Drop down the Spectrum menu and select Delete Displayed 
Spectra. 

NOTE: All spectra in the display area are removed. A deleted spectrum is 
actually removed from the window and cannot be recalled without going 
back to the Plot window and extracting it again. 

• Drop down the Spectrum menu and select Delete All 
Spectra. Note that all of the boxes at the bottom of the 
screen are empty, indicating that there are no spectra left in 
the window. 
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Now let's utilize the display functions you have learned to 
address a practical problem: the determination of peak purity. 
Using these spectrum display controls, you can quickly compare 
different spectra from within one eluting peak for an indication of 
peak purity.  

• In the Plot window, open PV_SAM01.RUN and zoom in on 
the fourth peak in the chromatogram at 3.45 minutes. 

• Transfer spectra from the front and back portions of this 
peak to the Spectra Manager window. 

• In the Spectra Manager window, configure the display for 
Multiple plots, 190.00-366.60 nm and Normalized. 
(Remember to click on the title bar to activate the Spectra 
Manager window.) 

• Turn on both spectra and note that they do not overlay 
perfectly, indicating the presence of co-eluting compounds in 
what appeared to be a single homogeneous peak. While 
visual overlays like this are useful for peaks with substantial 
impurities, numerical approaches, detailed in the next 
Tutorial, are less subjective and can be statistically 
validated. 

• To see the results of this exercise on a pure peak, repeat 
this on the peak eluting at approximately 5.0 minutes and 
observe how well the spectra are overlaid. 

To print reports of spectra extracted from a chromatogram, click 
on the Spectra Manager title bar, then drop down the File menu 
and select Print Spectra. The report will either be a single 
spectrum report (if the window currently is displaying one 
spectrum) or a spectral overlay, if multiple spectra are currently 
displayed on the screen. (See Appendix A for example of the two 
types of reports).  

Do not close PolyView2000. Instead, go on to the next Tutorial. 
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Tutorial: Spectral Math Functions 
A variety of spectral processing functions are available in the 
Spectra Manager window that help in the evaluation of spectral 
data. 

• Using the procedures from the previous Tutorial, transfer two 
spectra from the upslope and downslope portions from the 
impure peak at 3.45 minutes in PV_SAM01.RUN to the 
Spectra Manager window.  

• Configure the window to display multiple plots between 190 
and 367 nm with the ‘Normalized’ setting.  The vertical lines 
in the Spectra Manager window correspond to the Purity 
Parameter calculated for each spectrum. 

 
Upslope and Downslope Spectra  
from the Peak at 3.45 Minutes in PV_SAM01.RUN 
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• Display the numerical value for these Purity Parameters by 
dropping down the Spectrum menu and selecting View 
PuPs. In the dialog box, you can change the wavelength 
range for the Purity Parameter calculation and the values are 
instantly recalculated. 

NOTE: In PolyView2000, Purity Parameter is often abbreviated PuP. 

• Close the Purity Parameters dialog box by double-clicking on 
its Control menu box. 

The Purity Parameter in PolyView2000 is a primary means to 
distinguish between different spectra. However, the ability to 
discriminate between spectra is highly dependent on the 
wavelength range over which the calculation is made. 
PolyView2000 provides a means to optimize the wavelength 
range used in this calculation. Drop down the Spectrum menu 
and select Optimize PuP. Notice that the cursor is replaced with 
the hourglass, indicating that the Star Workstation is calculating. 
Following completion of the calculation, select Yes in the 
informational pop-up and the wavelength range in the Spectra 
Manager window is set to the values that result in the optimum 
separation of Purity Parameter values for the displayed spectra.  
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Screen Display Following Optimization of the Purity Parameter 

The optimum range for your spectra may not exactly match that 
shown, since it is dependent on exactly where in the peak that 
the spectra were extracted. 

The Optimize PuP function is particularly useful for determining 
the proper wavelength range to use in assessing peak purity 
using Purity Parameter plots (see Determining Peak Purity on 
page 71). 

For the next two exercises, replace the spectra in the Spectra 
Manager window with three spectra corresponding to the 
upslope, downslope, and apex of the pure peak at 5.0 minutes in 
PV_SAM01.RUN. Configure the Spectra Manager window to 
display Multiple Plots, Normalized in the range 190-367 nm. The 
screen should appear as shown below. 
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Screen Display of the Three Spectra  

Extracted from the Peak at 5.0 Minutes in PV_SAM01.RUN 

The statistical variation in the Purity Parameters for a number of 
spectra can be calculated. 

• Drop down the Spectrum menu and select Do Statistics. 

• A dialog box appears that lists all the spectra in the window, 
their correlation values, average and standard deviation. 
Initially, the wavelength range is set to what is selected in 
the spectrum window. Statistics over alternate ranges can 
also be calculated. 
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The Purity Parameter Statistics Dialog 

• Check the Accumulate Info box, change the wavelength 
range to 220-366.6 nm, and click on the Calculate 
pushbutton. Data for the new range is added to the original 
data. 

• Try several more ranges and note that the statistics report 
lengthens. The entire report can be viewed using the 
scrolling controls to the right of the report. 

• Select the Print pushbutton to obtain a printed report of the 
calculations (see Appendix A for an example of the PuP 
statistics report) for an example of the PuP statistics report). 

• The Purity Parameter statistics can be used to help in 
deciding the significance of subtle differences in values 
among several different spectra and for establishing 
expected correlation values for library searches. 

• By entering a Purity parameter target and/or a standard 
deviation in the fields composing the PuP Target group, you 
can express the purity parameter statistics relative to a 
standard. If filled, the Name field will be added to the report. 
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• Close the Statistics dialog box by double-clicking on its 
Control menu box. 

Spectra can be combined arithmetically in the Spectra Manager 
window. 

• With the screen configured as above, drop down the 
Spectrum menu and select Do Arithmetic. The Spectra 
Arithmetic dialog box will appear with all current spectra 
displayed. 

 
The Spectra Arithmetic Dialog Box 

• Edit the factor fields just to the right of each spectrum by 
replacing the 0.0 with 0.333. 

• Set the wavelength range to 190-367 nm and select 
Compute. 

• The spectrum that appears in the large graphics display is 
the average spectrum, since factors of 0.333 were used for 
each of the three source spectra. From here, the calculated 
spectrum can be sent to the Library Manager or the next 
storage location in the Spectra Manager. 

Close the PolyView2000 application by double-clicking on the 
Control Menu box in the main application window. 
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NOTE:  Spectra arithmetic functions are particularly useful for preparing spectral 
libraries which contain averaged spectra resulting from several different 
injections. To do this, transfer apex or area spectra from several different 
injections of a standard solution to the Spectra Manager window. 
Average the spectra using the spectra arithmetic functions and transfer 
the resulting spectrum to the Library Manager for inclusion in the library. 

Performing Library Functions 
PolyView2000 incorporates extensive Spectral Library functions. 
These capabilities allow the user to match spectra resulting from 
the injection of unknown samples with reference spectra 
archived in spectral libraries. The Library functions in 
PolyView2000 include the ability to build a library from a .RUN 
file, edit the library records, search the list of library entries for a 
specific name or key word associated with the record, and 
conduct spectral searches of the library. Spectral searches can 
either involve searching the library for a specific spectrum picked 
from a .RUN file or searching a .RUN file for a specific spectrum 
from the library. Initially, the library search can be narrowed 
down by restricting the retention time and Purity Parameter 
match windows. Then, the library spectra that meet these first 
criteria are considered and their spectral similarity with the target 
spectrum is quantified, providing “Dissimilarity” and “Similarity” 
indices. The library operations are some of the most complex in 
PolyView2000. They routinely involve the use of three different 
windows (Plot, Spectra Manager, and Library Manager) with 
movement of data (spectra) between the three windows.  

Like similar operations in other related disciplines (Mass 
Spectrometry, Infrared Spectrometry), the library functions in 
PolyView2000 provide qualitative information about an eluting 
peak by correlating an unknown “target” spectrum with a known 
reference spectrum. In UV spectrometry, this task is somewhat 
more difficult, since the information content of UV spectra is low 
(nearly identical spectra can be obtained from different 
compounds) and the spectra obtained can be influenced by a 
number of factors (pH, ionic strength, detector non-linearity, 
mobile phase absorbance, etc.). Consequently, care must be 
taken in the interpretation of data from a Diode Array Detector. 
At best, the spectral correlations obtained from library searches 
should be used as a means to confirm the identity of an eluting 
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peak after taking into account other criteria such as the retention 
time comparison with a known standard. In very few cases is it 
possible to draw conclusions about the identity of an unknown 
based on the UV spectrum alone without reference to a known 
standard. The quality of library matches will depend greatly on 
the conditions under which the library spectra were saved. It is 
important to use the same HPLC conditions when constructing a 
library as are to be used in the analysis of unknowns, particularly 
if the analytes are sensitive to minor solvent effects. Care must 
be taken to insure that the detector and other components of the 
system are in good working order to obtain the best library 
search results. If in doubt about the quality of the spectra 
contained in one of your libraries, it is probably best to reinject 
known reference standards and obtain new spectra. 

NOTE: For a detailed discussion on how library searches are conducted in 
PolyView2000 and how to interpret the results of a library search, see 
Library Searches on page 105. for an example of the PuP statistics 
report. 

In the following Tutorials, the primary library functions will be 
covered. Initially, you must “Create” a library disk file for storage 
of spectra. A Tutorial will be presented on Building and Editing 
that covers the techniques available to place spectra in a library 
and to add information to each library record that is helpful in 
characterizing it. PolyView2000 provides extensive editing 
capabilities for management of your disk libraries. Only the 
primary capability of locating a particular library record and 
editing its information section will be covered in this Tutorial. In 
the last Tutorial, the spectral search capabilities will be covered. 
It is important to keep in mind that the results actually obtained in 
library searches depend heavily on the nature of the analytes 
and the analytical conditions. It is important for each user to 
develop criteria based on their particular application for the 
interpretation of library search results. 

The Tutorials are based on hypothetical standard and sample 
chromatograms. The Standard (PV_STD01.RUN) contains 
several peaks for which spectra have been archived in the 
spectral library provided with PolyView2000 (PV_STD01.LBR). 
In the Tutorial, you will be asked to create your own library and 
to store spectra in it from PV_STD01.RUN. Your library should 
be nearly identical to the one provided (PV_STD01.LBR). Next, 
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you will be asked to determine if the peaks in the Hypothetical 
sample (PV_SAM01.RUN) match the peaks in the standard. 
Both the library you build and the one provided will be searched. 

PolyView2000 can have different types of libraries. Because of 
the way the spectra are stored in a library, spectra collected with 
different wavelength ranges and different bandwidths MUST be 
stored in different libraries. (Data collected at different data rates 
can be stored in the same library because data rates do not 
effect spectral characteristics.) For example, data collected with 
a wavelength range of 200 to 400 nm could not be stored in a 
library with data collected over a wavelength range 200 to 500 
nm. Also, data collected from 2 different diode arrays, e.g. the 
9065 and the 330, cannot be stored in the same library. 

Even though data with different acquisition parameters must be 
kept separate in different libraries, any library can be used to 
with any spectrum. The wavelength ranged searched with the 
wavelength range of overlap between the particular library and 
the target spectrum. For example, if the library has a wavelength 
range from 250 to 400 nm and the spectrum was taken from 300 
to 450 nm, the target spectrum will be reduced to a spectrum 
from 300 to 400 nm and the library search will occur. 

Therefore, it is desirable for most standards which will be used in 
a library to take data with the same wavelength and bandwidth. 
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Tutorial: Creating a Library 
From the Star Tool Bar, double-click on the PolyView2000 icon. 
PolyView2000 will open with the three primary windows 
displayed. 

• Click on the Library Manager title bar to make it the active 
window and select Create Library under the Library menu. 

• In the file selection dialog box that is displayed, select the 
EXAMPLES directory(double-click on it) and then edit the 
File name field to assign a name for the library you are about 
to create. Name the library MYLIB.LBR and select OK. If the 
file already exists, you need to delete it first. This can be 
done by pressing the Cancel button, then executing Library: 
Open to select MYLIB.LBR, then Library: Delete to delete it. 

After the name for the new library is selected, the required disk 
file is created and the library becomes the Current Library in the 
Library Manager window. A dialog box is displayed that allows 
you to add information to the library header. In the dialog box, 
add whatever information you like to the three fields and select 
OK. 

 
The Edit Library Information Dialog 

Don't close PolyView2000.  Instead, go on to the next Tutorial. 
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NOTE: It is important to distinguish how the Library Manger addresses different 
libraries. All libraries are maintained as disk files just as any other DOS 
file in the Star Workstation. The Library Manager maintains a list of those 
.LBR files to address during searches, called the Search List. In addition, 
one library can be designated as the “Current Library” for the Library 
Manager window. The Current Library is the one that is currently open 
for adding, editing, and deleting spectra, and is listed in the title bar of 
the Library Manager window. Libraries are added to the search list using 
the Add to List command in the File Selection dialog box. Also, when a 
new library is created, it becomes the current library and is added to the 
search list. A shortcut to making one of the libraries in the search list into 
the Current Library is to double-click on its name in the search list. 
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Tutorial: Building and Editing a Library 
Be sure to complete the previous Tutorial on creating a library. 
The screen should now display the three primary PolyView2000 
windows and MYLIB.LBR should be the only library in the 
Search List in the Library Manager window. 

To place a spectrum into a library, you must first extract it from 
the .RUN file and transfer it to the Spectra Manager window. 

• Click on the title bar of the Plot window to make it the active 
window. 

• Plot out the absorbance chromatogram of PV_STD01.RUN 
at 253.6 nm (refer to Plotting a Chromatogram on page 2. 

• Transfer a spectrum from the apex of each peak to the 
Spectra Manager window Examining Spectra from a 
Chromatogram on page 35. 

 
Screen Configuration for Building a Library File 
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• Click on the title bar of the Spectra Manager window to make 
it the active window. 

• Select Edit Spectra in the Spectrum menu. 

A dialog box is displayed, that allows you to view and edit a 
variety of information that is attached to each spectrum in the 
Spectra Manager. This information, along with the spectrum itself 
constitutes the “Spectrum Record” that can be transferred 
between the various PolyView2000 windows and becomes a 
permanent part of the disk file when it is stored in the Library. 
The number in the upper left corner of the dialog box indicates 
which of the seven spectrum registers you are currently viewing 
and editing. 

 
The Edit Spectra Dialog Box 

• Initially, change the Valid wavelength range to 200-366.6 nm 
(select Edit in the Valid Wavelength range box and set the 
new range in the small dialog box that appears). 
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• Add or alter any information you would like in the five edit 
fields (Name, Note, Operator, Method and Instrument). 
Name the peak Compound #1. 

• Once this has been completed, you can obtain a printed 
report of the spectrum and its associated information. Select 
the Print pushbutton and wait for the report to be printed. 

Select Next to access the next spectrum in the Spectra Manager 
window. Note that you must verify the edited changes. Select 
Yes. Continue editing the spectrum information sections for each 
of the six spectra in the Spectra Manager window. At this point in 
the Tutorial, all of the spectra and their associated information 
sections are temporarily stored in the Spectra Manager window. 
They are not yet part of the library. 

After the last spectrum in the Spectra Manager window has been 
edited, select Quit. You are now ready to begin adding these 
spectra to the library (MYLIB.LBR). 

• In the Spectra Manager window, select Single Plots under 
the Display menu. The spectrum in register position #1 is 
displayed. 

• Next, select To Library Manager under the Spectrum menu. 
The displayed spectrum in the Spectra Manager window is 
transferred to the single spectrum register in the Library 
Manager window (i.e., it becomes the Current Spectrum in 
the Library Manager). Add it to the Library by selecting Add 
Spectrum to Library in the Library menu.  

NOTE: In PolyView2000, multiple spectra can be transferred from the Spectra 
Manager window to the Library Manager window and added to the 
current library in a single step. 

• To add the other spectra in the Spectra Manager window to 
the library, go back to the Spectra Manager window and 
select Multiple Plots under the display menu. Then, click on 
the boxes under the spectra to de-select spectrum # 1 and 
select spectra #2 through #6. 

• Next, select To Library Manager under the Spectrum menu.  
You will be told that since multiple spectra are selected, you 
cannot change the Library Manager’s current spectrum, and 
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asked if you want to add the 5 selected spectra to the 
current library. Answer Yes.  

NOTE: After the transfer of multiple spectra, a small message window informs 
you of the success of the operation and disappears after a few seconds. 
You can close this message window earlier by pressing the Enter key or 
clicking on the window.  

At this point, the library should contain spectra for all the peaks 
in PV_STD01.RUN. In the Library Manager window, select 
Select/Edit Library Record under the Edit menu. Notice that all of 
the spectra added to the library are listed. 

A library can be searched for key words (in the Name and 
Notepad fields of each record) as a rapid means of locating a 
desired record. Try that now: 

• Select Change Parameters. 

• Type a key word in the Search Text field that can be found in 
the Name or Notepad fields of only one of the records. 

• Check the Search in Name and Search in Notepad boxes 
and select Do Search. 

Notice that the list of records is updated to include only those 
with the specific key word. The other records are still in the 
library, but are not displayed in the list. 

Individual records in the library can be edited or deleted. 

• First, list the entire library by doing a key word search with 
only a space (use the space bar) in the Search Text field. 
Then, select one of the records from the list in the List 
Library Records dialog box by pointing and clicking with the 
mouse. 

• Select Edit Record. A dialog box appears that is very similar 
to the Edit Spectra dialog box in the Spectra Manager 
window. This is your interface to the actual data stored on 
disk in the library. You can alter the information stored for 
that particular spectrum or delete the record from the library 
altogether. For more information on the functions available in 
this dialog box, press the “Help” button. 
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MYLIB.LBR after addition of spectra 

 
The Edit Library Records Dialog Box 
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• Select Quit to close the dialog box. 

Don't close PolyView2000. Instead, go on to the next Tutorial to 
learn how to conduct spectral library searches. 

NOTE: In the above description on building a library, the information associated 
with each spectrum (Name, Operator, etc.) was added to the spectrum in 
the Spectra Manager window prior to its transfer to the Library Manager. 
Alternately, this information could have been added after the spectrum 
was transferred to the Library Manager window. The spectrum 
information fields are accessible after the spectrum becomes a part of 
the disk library and this information could have been edited after all 
spectra were in the library (see the above Tutorial). Also, the information 
is accessible when the spectrum is the Current Spectrum in the Library 
Manager window (i.e., after it is transferred from the Spectra Manager 
window but before it is added to the library). To access the Current 
Spectrum in the Library Manager, select Edit Spectrum under the 
Spectrum menu. When the desired information has been added, the 
spectrum can be added to the library directly. In building libraries, use 
whatever method seems the most straightforward for editing the 
information associated with the spectra and adding them to the library. 

Tutorial: Conducting a Spectral Library Search 
The first step in conducting a library search is to extract a 
spectrum for the peak of interest from the .RUN file. 

• In the Plot window, select Open File under the File menu. 

• In the file select dialog box, locate PV_SAM01.RUN and 
double-click on it. The file will be plotted in the window and 
for this Tutorial, the default plot conditions can be used. 

• In the Spectrum Manager, select Delete All Spectra in the 
Spectrum menu, then set the Display mode to Single Plot. 

• The target spectrum for all library searches is the Current 
spectrum in the Library Manager window. The spectrum is 
transferred to this window in the same manner as was used 
in the previous Tutorial (i.e., by transfer through the Spectra 
Manager window). Using the cursor, extract the apex 
spectrum from the peak at 5.0 minutes and transfer it to the 
Spectra Manager window. Activate the Spectra Manager 

PolyView2000TM 57 



window and select To Library Manager under the Spectrum 
menu. You will not be asked if you want to add the spectrum 
to the current library because the Spectrum Manager was in 
the 'Single Plot' Display mode. 

In the Library Manager, a search list of disk libraries must be 
built. The library you created in the previous Tutorial should 
already be listed in the search list. Let's add the library provided 
with PolyView2000. 

• Click on the Library Manager title bar to make it the active 
window and select Open Library under the Library menu. 

• Select PV_STD01.LBR from the list and activate the Add to 
List pushbutton. Click on the Cancel pushbutton to close the 
dialog box. Note that it becomes the current library and is 
added to the Search List. 

 
Screen Configuration for Library Search 

To send a single spectrum to the Library Manager without being 
asked about adding it to the library, set the Spectra Manager to 
the 'Single Plot' mode. 
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NOTE: Management of the contents of the Search List is accomplished with the 
controls under the Search menu. For more information on the use of 
these controls, refer to On-Line Help (Help:Commands:Search). Also, 
any of the libraries in the list can be designated the Current library by 
double-clicking on its name in the list. That library is then opened for 
editing. Note that the Current library is always listed in the title bar of the 
Library Manager window. 

Now that the target of the search is the Current Spectrum in the 
Library Manager, and the search list of libraries is built, you can 
conduct the search. 

Select Search for Spectrum under the Search menu. 

The Library Search dialog box is displayed that is used to set the 
search parameters and display the results. Refer to Library 
Searches on page 105 for more information on the way in which 
library searches are conducted and search parameters are set. 

 
The Library Search Dialog Box 
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For now, simply change the wavelength range to 200-366.6 nm 
and leave all the other controls at their default settings. Select 
the Search pushbutton. The search is conducted and, after a 
short period of time, the results are displayed on the screen.  

 
Results of a Library Search 

Following the search, a wide variety of additional functions are 
available. Using the controls in the list box at the bottom of the 
screen, view the entire library search text report. This report lists 
the best 5 library matches (sometimes fewer if there were not 5 
library spectra that met the retention time and Purity Parameter 
criteria.) and the search conditions, followed by the information 
pertaining to the target and match spectra. This report can be 
printed (Print List) and an example is shown in Appendix A.  
Other controls in the dialog box enable you to access all of the 
matches individually (Next and Prev) and obtain a detailed report 
for each (see Appendix A as an example). 

NOTE: The library search results are ranked in order of decreasing similarity. 
For a discussion of the indices used to quantify the match between two 
spectra, see Library Searches on page 105, or refer to On-Line Help. 
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By default, the result of the search (if successful) is to display the 
target spectrum overlay with the best match. Since these two 
spectra are often very close, their difference is displayed as a 
spectrum in the lower portion of the spectrum plot. To not display 
this difference, click on the check box titled Difference to 
uncheck it. This provides you with a larger size spectral overlay.  

When you are finished using this particular target spectrum, 
close the search dialog box by double-clicking on its Control 
Menu box. To search any of the other peaks in the 
chromatogram, simply transfer a spectrum from the peak to the 
Library Manager (through the Spectra Manager window) and 
select Search for Spectrum. Try that now. Determine the name 
of the compound eluting at 8 minutes in PV_SAM01.RUN by 
searching the two libraries. 

Close PolyView2000 by double-clicking on the Control Menu box 
in the main application window. 

Reporting Data 
PolyView2000 has two modes of operation: the interactive 
mode where the user is actually sitting at the Star Workstation, 
and the non-interactive mode, where functions and reports are 
generated automatically using a set of pre-defined conditions 
contained in a PolyView2000 reports method. Most of the 
windows and dialog boxes in PolyView2000 permit you to 
document your work through an interactive printed report (select 
either the Print command under the File menu or the Print 
pushbutton in dialog boxes). Examples of these reports are 
presented in Appendix A.  Most of the functions (and reports) 
that can be performed interactively can also be conducted in the 
non-interactive mode. In Automating PolyView2000 Operations 
on page 90 you will learn how to automate these data processing 
and reporting functions. In PolyView2000, your primary control 
over these non-interactive reports is through the Reports 
window. Non-interactive reports are specified using the Method 
Builder application (see the LC Star Workstation Manual) which 
can be accessed directly from the Reports window in 
PolyView2000. When the Method Builder application is accessed 
in this manner, control is passed directly back to PolyView2000 
when it is closed. Once a report method is specified, the report 
can be generated and stored as a disk file. Then, you can view 
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or print the report at some later time. The following Tutorial is 
broken into two parts. The first part covers the viewing and 
printing of an existing report file on the disk. The second part 
covers the specification and generation of a report file. 

NOTE: In the following Tutorial, some of the files in the EXAMPLES directory will 
be modified and/or created. Prior to performing this Tutorial, you should 
ensure that you are working with original copies of the data files called 
for. If you are not sure whether these files have been modified by 
previous use of the Tutorial, re-install PolyView2000 from the CD. 

Tutorial: Making a Report 
The first step in making a report is to construct a report method 
in the Method Builder application. 

Activate the Reports window (if not already active). 

Drop down the Reports menu and select Edit Method. 

The Method Selection dialog box allows you to create a new 
method or edit an existing method. Let's create a new method. 

 
The Method Selection Dialog Box 
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Select the New Method pushbutton and accept the default bus 
address of 4, the address used in collecting the Example data 
files. Control is transferred to the Method Builder application and 
the window used to specify reports is displayed. 

 
The PolyView2000 Reports Method Window 

NOTE: For more details on the operation of the Method Builder application, refer 
to the Data Acquisition with LC Control Operation Manual. 

The Report Method dialog box is used to manage the list of 
report types called for in the .MTH file. First, let's call for the 
generation of a Single Plot report. 

Select Add and a list of the reports that can be generated is 
shown. 

 
Reports that can be generated automatically 
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Select the Single plot report and press OK.  Note that a dialog 
box is displayed that allows you to specify the parameters for the 
report. 

 
Single Plot Report Parameters 

Leave the Plot type at Chromatogram (the default), set the 
wavelength range to 220-311 nm, and leave the Time and Scale 
ranges at their default settings. 

These parameters will generate a report of the entire data file 
using the average absorbance from 220 to 311 nm with the 
absorbance range autoscaled. 

Click on Done at the bottom of the window. Notice that the Single 
Plot is included as the first report specified. 
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A Single Plot Report was added to the Report List 

Now, let's include a library search in the report. 

Click on Add and select Library Search. 

Note that the Select Library File dialog box is displayed. You now 
specify the libraries that you want to use for a library search. 
Once you have specified the library, you can specify the 
parameters to use in conducting an automated library search. 
Let's duplicate the search that was conducted in the Tutorial, 
Conducting a Spectral Library Search. 

Leave the Report Type set to Short Graphics. 

Set the wavelength range to 190-366.6` nm and leave all of the 
other fields at their default settings. 

Now, build a list of libraries to search. 

Select Add Library and the Library Select dialog box is displayed. 

Select MYLIB.LBR. Select Open and the library will be added to 
the search list. Repeat this for the PV_STD01.LBR file. 

Back in the Report Method window, select Add to append the 
Library Search report to the list of reports. 
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The Library Search Report, showing 

the list of libraries to be searched 

NOTE: Once a series of reports have been entered into the list, the controls in the 
Report Method window are then used to manage the list. You can edit or 
delete selected reports and rearrange the order that the reports will be 
generated (and appear in the disk file). For details on the operation of these 
list management controls, see On-Line Help (search for Report Method). 

Now that the types of reports have been specified, you need to 
assign the .MTH file a name and save it to the disk. 

Drop down the File menu and select the Save As command. 

In the dialog box, assign it the name MYMETH. You do not need 
to add the .MTH extension. It is automatically added to the 
method name. 

Close the Method Builder application by clicking on the Control 
Menu box in the main application window. 
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When the Method Builder application is exited, control is 
returned to PolyView2000, just where you left off (in the Reports 
Window). You can now generate a report using the .MTH file you 
just created. To generate the report, you must specify the .RUN 
file that is the source of the raw data, the .MTH file that will be 
used to process the data, and the .SRP file that becomes the 
disk file containing the report. 

Drop down the Reports menu and select Create Report.  

 
Report Creation Dialog Box 

Press Select Data File and choose PV_SAM01.RUN as the raw 
data file from which to construct the report. 

Press Select Methods File and choose MYMETH.MTH as the 
method to construct the report. 

Press Select Reports File, type MYREPORT into the File name 
field and select OK.. 

Press OK to start the report generation. A dialog box is displayed 
that informs you of the progress. After the report is completed, it 
is automatically displayed in the Reports window. It can now be 
accessed or printed just as any other existing report file. 
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MYREPORT.SRP displayed in Reports Window 

Close PolyView2000 by clicking on the Control Menu box in the 
main application window. 

NOTE: The above Tutorial covered the building of a new report generation 
method. PolyView2000 also allows you to edit an existing report method 
by selecting Edit Method under the Report menu and specifying an 
existing .MTH file in the File Select dialog box. You can then add new 
report types to the file or edit the ones already in the .MTH file. 
 
You may also extract the report method directly from an existing .SRP 
file even if the original .MTH file used to generate it doesn't exist on the 
disk. To do this, select Edit Current Method under the Report menu. The 
dialog box that appears allows you to generate a .MTH file with the same 
root as the .SRP file. You may choose another name if desired. 
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Tutorial: Viewing and Printing of an Existing Report 
If you have not already executed the previous Tutorial, do so to 
create a report file. 

If PolyView2000 is not already running, start PolyView2000 now. 

• Select New Reports Window under the Windows menu. 

To view a report file, select Open Report under the Reports 
menu and select MYREPORT.SRP from the EXAMPLES 
directory. Notice that as you select the disk file, the pages in the 
report are listed. This enables you to confirm the contents of the 
report before it is called into the window. Select OK to confirm 
your selection. 

 
Report window displaying an .SRP file 
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The first page of the specified report is displayed in the window. 
Initially, it is displayed in color, and the full page is reduced in 
size to fit within the window. Access the next page of the report 
by selecting Next Page under the Page menu. The commands 
under this menu can be used to access or delete sequentially the 
individual pages in the report. The Next Page and Previous Page 
commands can also be given through the Page Up and Page 
Down keys in the numeric keypad of your keyboard. The report 
can be viewed in monochrome by selecting that mode under the 
Page menu. 

 
Library Search Report Zoomed in 

Next, drop down the Report menu and select View Page List. 
This allows you to view the method that was used to generate 
the report and the resulting pages. Any of the individual pages 
can be accessed by selecting them from the page list and 
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selecting the View Page pushbutton. Select a page of the Library 
Search Report. 

Particular details in the report can be viewed by moving the 
cursor to the desired region of the report by a click and drag 
operation of the mouse. Zoom in on the region of the report 
dealing with a library match. Notice that the remainder of the 
report can still be accessed using the scrolling controls at the 
bottom and right of the screen. Clicking the left mouse button 
anywhere within the report un-zooms the display. 

Drop down the File menu and select Print Page. The currently 
displayed page is printed on the Star Workstation printer. If 
desired, all the pages in the report can be printed using the Print 
File command in this menu. 

Determining Peak Purity 
A primary feature of a Diode Array Detector such as 330 is the 
ability to provide information on the purity of chromatographic 
peaks. These peak purity determinations are made by assessing 
the degree of difference in the UV spectra across the width of a 
peak. There are a number of mathematical parameters that can 
be used to compare spectra. The Purity Parameter used in 
PolyView2000 is perhaps the most sensitive to minor co-eluting 
impurities (contaminants) within a peak of interest (the analyte). 

Purity Parameter 
For a given wavelength range, the Purity Parameter is the 
average wavelength weighted by the square of the absorbance. 
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Consequently, by examining the Purity Parameter values across 
a peak, you can quickly determine the presence of contaminants. 
Rather than examining a table of Purity Parameter values, 
PolyView2000 provides the ability to plot the Purity Parameter as 
a function of time. If the peak is free of co-eluting compounds, 
the Purity Parameter will not change over the course of the peak 
and it will appear with a flat top. However, if impurities are 
present, the top of the peak will slope, indicating that the Purity 
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Parameter is not consistent across the width of the peak. In 
addition to the Purity Parameter, other qualitative parameters 
associated with UV spectra can be plotted and provide 
information on peak purity, including the wavelength of maximum 
absorbance and the ratio of absorbances at two different 
wavelengths. Like the Purity Parameter plot, a flat topped peak 
indicates that the parameter is not changing with time and 
provides a measure of peak homogeneity. 

The accuracy of all the measures of peak purity are dependent 
on a number of factors. There must be some degree of 
separation between the analyte and contaminant to create a 
difference in the UV spectra across the width of the peak. If the 
two (or more) compounds exactly co-elute, then the UV spectra 
will not change across the peak and it will appear to be pure. 
Care must be taken to maximize the efficiency of your HPLC 
system. A Diode Array Detector cannot make up for low 
efficiency columns and/or inadequate separation techniques. In 
addition, the degree of difference in the UV spectra between the 
analyte and the contaminant will have a profound effect on the 
peak purity determination. If spectral differences are small, it will 
be very difficult to determine impurities. However, the Purity 
Parameter is very sensitive to even slight spectral differences 
and this will not often be a problem for PolyView2000. A final 
consideration in peak purity determinations is the wavelength 
range used in specifying the plots. It is possible for the spectra of 
an analyte and a contaminant to be very similar over a certain 
portion of the UV spectrum and different over another portion. It 
is important to carefully consider the wavelength range used to 
assess peak homogeneity. To assist you in selecting the proper 
wavelength range for plotting the Purity Parameter, you can use 
the optimization routine in the Spectra Manager under the 
Spectrum menu. 

PolyView2000 provides several ways to construct Purity 
Parameter plots. They can be plotted interactively in the plot 
window or generated automatically in a non-interactive report. In 
addition, the non-interactive Peak Purity Survey report presents 
the same information in a slightly different format. In this report, 
the Purity Parameters of all spectra within a peak are compared 
with the Purity Parameter of the apex spectrum and, if different, 
the peak is marked. With experience, you will find the technique 
that best suits your application. 
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In the previous tutorials, you have already learned the 
techniques that are required to conduct these Peak Purity 
determinations. The basic technique for plotting a .RUN file was 
covered in Plotting a Chromatogram on page 25 and preparing 
non-interactive reports was covered in Reporting Data on page 
61. Consequently, the details of these operations will not be 
covered here. Instead you will be asked to refer to these 
previous tutorials. The data file used in this tutorial, 
PV_SAM01.RUN, has several impure peaks that should become 
obvious as you work through this tutorial. 

Note that Multicomponent Analysis can be also used to assess 
the purity of a peak, as detailed in Purity Evaluation by MCA on 
page 100. 

Tutorial: Purity Parameter Plots 
The first step is to configure your screen to compare two plots. 

• At the Workstation Star Tool Bar, open PolyView2000 by 
double-clicking on the PolyView2000 icon. 

• Configure PolyView2000 with only the Plot window active, 
hiding both the Spectra Manager and Library Manager 
windows. 

• In the Plot window, plot out PV_SAM01.RUN at 254 nm. 

• Drop down the Plot menu and select Duplicate Plot Window. 
Wait for the plot to appear and then select Arrange Visible 
under the Window menu. 

Your screen should display two identical plots of the file. This is 
the most convenient screen configuration for determining peak 
purity because you can view the absorbance chromatogram in 
one window and the purity information in another. 
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Duplicated Plot Window 

You must now specify the Purity Parameter plot. 

• With the focus on the bottom window, drop the Plot menu 
and select Plot Parameters. 

• Specify a Purity Parameter plot with a wavelength range of 
200-366 nm. Accept the defaults for all of the other 
parameters. 

The Purity Parameter is now plotted as a function of time 
between the upslope and downslope inflection points of each 
peak. Notice that the peak at 3.5 minutes has a sloping top, 
indicating that the Purity Parameter is changing across the width 
of the peak. 
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Purity Parameter Plot indicates impure peak  

at 3.5 minutes 

You can easily verify the spectral dissimilarities in the impure 
peak by transferring the upslope and downslope spectra to the 
Spectra Manager window. In either Plot window, extract spectra 
corresponding to the upslope and downslope of the peak at 3.5 
minutes. Activate the Spectra Manager window and observe the 
differences in the two spectra. 

NOTE: The peak at 3.9 minutes in PV_SAM01.RUN also has a significant 
impurity that can be clearly detected by plotting the Purity Parameter 
over the range of 224-278 nm. 

Don't close PolyView2000. Instead, go on to the next tutorial.
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Tutorial: Peak Purity Survey Report 
The Peak Purity Survey report is a non-interactive report and 
therefore must be specified in the Method Builder application. 

• Call up the Reports window and create a new report method 
(see Tutorial: Making a Report on page 62). 

• In the Method Builder application, select Add and set the 
type of report to Peak Purity Survey and Say OK. 

In the dialog box, you can specify the conditions for report 
generation. For an example of a peak purity survey report, see 
Appendix B. 

• Set the PuP Interval field to 2 nm. 

• Set the wavelength range to 200-367 nm and leave all other 
parameters at their default conditions. 

• Select Done and assign the report method the name of 
PURITY.MTH. (Use the Save As command under the File 
menu.) 

• Close the Method Builder application by clicking on the 
Control menu in the main application window. 

Now, let's use the report method to determine peak purity on a 
file. Back in the PolyView2000 Reports window, create a report 
of the data file PV_SAM01.RUN using the PURITY.MTH method. 
Call the report file PURITY.SRP (see Tutorial: Making a Report 
on page 62). The report displays the absorbance chromatogram 
(at the wavelength used for peak sensing) with impure peaks 
shaded. (Note that the peak at 3.5 minutes is indicated as being 
impure. 
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Peak Purity Survey Report showing  

impure peak at 3.5 minutes 

Close PolyView2000 by double-clicking on the Control Menu box 
in the main application window. 

Performing Peak Sensing 
Several functions within PolyView2000 rely on an accurate 
determination of peaks in a chromatogram. To provide corrected 
spectra that accurately reflect eluting peaks, the baseline profile 
must be determined with precision. Also, many of 
PolyView2000's automated functions require the determination 
of peak placement within a chromatogram. It is the job of the 
peak sensing algorithm to accurately determine where a baseline 
segment starts and stops and where eluting peaks are located. 
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There are a number of user-selectable parameters that must be 
set to insure accurate peak sensing. As with most data systems, 
including the Interactive Graphics application in the Star 
Workstation, you must set the peak width and S/N value (the 
threshold parameter) according to the peak width and size you 
expect. In addition, since you are dealing with multi-channel 
data, in PolyView2000 the wavelength used for peak sensing 
must be specified. A single wavelength or a wavelength range 
can be specified. All of the peak sensing parameters can be time 
programmed to accommodate changing conditions over the 
course of a chromatographic run. 

Like the reports method, a separate portion of the Star 
Workstation .MTH file is set aside for the PolyView2000 peak 
sensing method. This enables peak sensing to be performed 
automatically under the control of the System 
Control/Automation application. Along with this, the Method 
Builder application is used to specify and manage the peak 
sensing method. Within PolyView2000, a separate window is 
provided in which to manage the peak sensing functions. In this 
Peak Sense window you can view a chromatogram at the peak 
sensing wavelength, view and alter the detector noise monitor 
data, access the Method Builder application, and conduct peak 
sensing on a file. 

The following tutorials cover the basic operations of constructing 
a peak sensing method and performing peak sensing on a data 
file. In the last tutorial, the procedure for defining a new noise 
monitor will be covered. 

NOTE: For more detailed information on peak sensing in PolyView2000, 
including procedures to follow for troubleshooting peak sensing, refer to 
Peak Sensing on page 109. 
 
In the following Tutorial, some of the files in the EXAMPLES directory will 
be modified and/or created. Prior to performing this tutorial, you should 
ensure that you are working with original copies of the data files called 
for. If you are not sure whether these files have been modified by 
previous use of the Tutorial, reinstall the PolyView2000 software from the 
CD using your serial number.  
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Tutorial: Building a Peak Sensing Method 
From the Star Workstation Star Tool Bar, double-click on the 
PolyView2000 icon to activate the application. 

Drop down the Windows menu, activate a New Peak Sense 
Window and maximize it. 

You are now ready to build a new peak sensing method. 

• Under the Peak Sensing menu, select Edit Method. 

• To define a new .MTH file, select New Method in the dialog 
box. Accept the default bus address (all methods sections 
are attached to an address, used under automated 
operation). Control will be transferred over to the Method 
Builder application and the Peaksense Time Program dialog 
box will appear. In this window, the default peak sensing 
time program is in the list box at the bottom of the window. 
The operation of the edit controls in this window is similar to 
other windows within the Method Builder application. Modify 
the Peak Sensing Method as follows. 

 
The Peak Sense Time Program Window 
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• Click on the first line 0.00 Peaksense..., and alter the 
wavelength range fields to 273-273 nm. Note that, unlike 
previous versions of the Method Builder, the numbers 
change immediately in the Method listing and that there is no 
Change button. However, the parameters do not actually 
change in the method until you save the method. 

• Click on the second line 0.00 S/N Threshold... and change 
the S/N value to 6. 

• Click on the third line 0.00 Inhibit Integrate... and change the 
end time to 2.00 minutes. This ensures rejection of the 
region containing the void peak. 

• Then, click on Add twice. This creates two new lines in the 
method. 

• Click on the second of the new lines and change the event to 
Peaksense, the time to 16.0, and the wavelength range to 
215-215. 

• Click on the first of the new lines and change the event to 
S/N Threshold, the time to 19.5 and the S/N value to 10. 
Your screen should look like the following. 

 
The New Peak Sensing Time Program 
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Next, assign a name to the method and save it to the disk. 

• Drop down the File menu and select Save As. 

• Save your method as PSENSE.MTH in the EXAMPLES 
directory. 

• Close the Method Builder application and note that control is 
passed back to PolyView2000 right where you left off. 

Don't close PolyView2000. Go on to the next tutorial to learn how 
to use the method you built to perform peak sensing. 

NOTE: The above tutorial covered the building of a NEW peak sensing method. 
PolyView2000 also allows you to edit an existing peak sensing method 
by selecting Edit Method under the Peak Sensing menu and specifying 
an existing .MTH file in the File Select dialog box. Control is transferred 
to the Method Builder application with the specified .MTH file already 
loaded. It can then be edited and saved for use later.  
 
A similar feature allows you to extract the peak sensing method directly 
from an existing .RUN file even if the original .MTH file used to generate 
it doesn't exist on the disk. To do this, select Edit Current Method under 
the Peak Sensing menu. The dialog box that appears allows you to 
generate a .MTH file with the same root as the .RUN file. Simply select 
OK in the dialog box that appears and control will be transferred to the 
Method Builder application with the .MTH file just created loaded into the 
window. If a file by that name already exists on the disk in the current 
directory, you will be given the opportunity to verify your selection to 
prevent inadvertently overwriting it. 

Tutorial: Conducting Peak Sensing 
To begin this tutorial, your screen should be configured as in the 
last tutorial, with a single Peak Sense window. The task will be to 
perform peak sensing on BASECORR.RUN using the method 
you built in the last tutorial. Drop down the File menu and select 
Open File. Select BASECORR.RUN in the EXAMPLES directory 
and then OK. The file is plotted in the window. 
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BASECORR.RUN in Peak Sense window 

NOTE: The peak events are displayed in both the Peak Sense window and the 
Plot window (optional). These events are color coded as follows: White-
Apex, Red-Peak Start, Yellow-Peak End, Purple-Inflection points, Dark 
Blue-Valley points, and Lt. Blue-Shoulder. The placement of peak events 
in a chromatogram indicates how well the peak sensing method was 
tailored to the actual chromatogram. For more information on how 
PolyView2000 conducts peak sensing and how to assess peak sensing 
results, see Peak Sensing on page 109. 

Now, let's perform the peak sensing operation. Select Do Peak 
Sensing under the Peak Sensing menu. In the dialog box, select 
the file you created, PSENSE.MTH, in the EXAMPLES directory. 
Notice that the peak sensing method is listed on the screen. 
Select OK. Peak sensing is automatically performed. 
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Often, the peak sensing method you specify cannot be executed 
exactly as it is called for in the .MTH file. For instance, time-
programmed changes in peak sense parameters (wavelength, 
peak width, etc.) cannot be made within a peak. When this 
occurs, a dialog box appears that informs you of this situation. 
This is the case for the BASECORR.RUN file and the View Peak 
Sense Log dialog box is displayed on the screen. The Peak 
Sense Log shows the original method you specified, the resulting 
method (as executed), and the reasons why it was modified. 
After viewing the information, select Quit. 

 
Peak Sense Log showing changes to method 

Following the peak sensing function, the display is updated to 
reflect the new peak sense results. 
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New Peak Sense Results 

The chromatogram display in the Peak Sense window is very 
similar to the display in the Plot window, but it only displays the 
time-programmed absorbance specified in the Peak Sensing 
Time Program. Flags at the top part of the screen indicate where 
time-programmed peak sense events were executed.  By 
default, the whole file is displayed and automatically scaled. You 
can use the mouse and the View menu to modify the time and 
amplitude settings. 

Close PolyView2000 by double-clicking on the Control Menu box 
in the main application window. 
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Tutorial: Troubleshooting Peak Sensing 
Attached to all .RUN files is noise data transmitted to the Star 
Workstation from 330 when it is in the MONITOR state, just prior 
to the start of the run. During the peak sensing operation, 
PolyView2000 determines the level of chromatographic noise 
from this monitor data and differentiates peaks from noise using 
the S/N ratio you set in the peak sensing time program. 
Occasionally, the run monitor associated with the .RUN file may 
not be accurate, possibly due to the presence of a late eluting 
peak from a previous run or a gradient program that had not yet 
stabilized prior to the run monitor period. PolyView2000 provides 
the ability to redefine the data used as the noise monitor in these 
situations and this function will be illustrated here. Configure 
PolyView2000 with a single Peak Sense window and call up 
BADMON.RUN from the disk. 

NOTE: See Peak Sensing on page 109 for more information on how PolyView2000 
conducts peak sensing and how to set the peak sensing parameters. 

 
BADMON.RUN showing no detected peaks 
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If the file is in the original state, you will notice that the peak 
sensing function did not detect any peaks and the noise value at 
the upper left corner of the screen is very high. If this is not the 
case, this tutorial has already been executed on the file; restore 
the file to its original state by executing the Remove User 
Monitor command in the Peak Sensing menu. 

You can examine the run monitor: 

• Drop down the File menu and select View Run Monitor. You 
will see that several high absorbance spikes occurred during 
the monitor. 

 
The Run Monitor dialog box 

• Using the wavelength control, you can view the run monitor 
data at any of the diodes which were used to collect the 
data. Select Quit to close the dialog box. 

If a file has a noise monitor that is corrupted or inappropriate, like 
BADMON.RUN, you can select a portion of the baseline in the 
chromatogram to be used for the noise calculation. This is called 
the User Monitor and after it is specified, peak sensing is 
automatically repeated. 

• Drop down the Peak Sensing menu and select Define User 
Monitor. 
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The controls in the dialog box that appears are used to select a 
portion of the file as the noise monitor. 

 
The Define User Monitor dialog box 

• Select a portion of the baseline between 0 and 1 minute 
using the click and drag method. When you do this, the plot 
will zoom and a message will be displayed in the Number of 
Points field. If the piece of baseline is too large, Too many 
points will be displayed and you will need to select a smaller 
portion of the baseline until the proper number of points is 
selected. Use Select from Left Edge. Try for a number 
between 26 and 74. When assigning the User Monitor, be 
sure to use a flat portion of the baseline, free from eluting 
peaks. To autoscale the plot after selecting a new region, 
double-click left of the Absorbance axis, where the cursor 
becomes a double-headed vertical arrow. 
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Section of Baseline chosen as User Monitor 

• After the number of points is refined, select OK and peak 
sensing will automatically be performed using this new 
monitor. 

When the plot is displayed, you will note that normal peak 
detection has occurred (see the following figure). Also, the new 
noise value is displayed in the upper left corner of the screen. 
The new monitor data can be viewed in the same manner as 
before. This time, select View User Monitor under the File menu. 
The dialog box that is displayed is very similar to the View Run 
Monitor dialog box. 
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BADMON.RUN with proper Peak Sensing  

after definition of a User Monitor 

Close PolyView2000 by double-clicking on the Control Menu box 
in the main application window. 
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Automating PolyView2000 Operations 
One of the primary features of the PolyView2000 Spectral 
Processing Application is the ability to conduct automated 
analyses of the spectral data from the 330 or 9065 diode array 
detectors. Instead of having to process the data manually after it 
is collected, the Workstation has the ability to perform many of 
these functions automatically, immediately after data collection. 
The PolyView2000 functions that can be performed in this 
manner include peak sensing to locate the peaks in a 
chromatographic run and any of the non-interactive reports. The 
functions in the non-interactive reports allow you to perform 
sophisticated analyses of diode array spectral data in an 
automated fashion. 

You can automatically add PolyView2000 functions to the 
processing of a diode array data file at the end of each 
chromatographic run by adding a PolyView2000 method 
associated with the detector (by means of the bus address) will 
be executed. During an automated sequence of injections, the 
PolyView2000 reports that are generated are written to a 
permanent disk file with a .SRP extension. These reports will 
also be printed automatically if the Automated Printing is enabled 
in System Control (at the bottom of the Automation menu). If you 
don't wish these reports to be printed automatically, simply 
disable the autoprint function. The .SRP files will still be 
generated and will be available for viewing in the Reports 
window. In addition to the generation of PolyView2000 report 
files during live runs, these .SRP files can be generated during a 
Recalculation sequence in System Control. 

Using On-Line Help 
There are three ways to access On-Line Help in PolyView2000: 
the F1 key, the Help menu, and the Help push button which is 
present in most dialog boxes. 
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Tutorial: Using On-Line Help 
Pull down the Help menu. Select Using Help to display the 
information file provided with Windows. Learn the basics, then 
close the Help window. Also try Index, Commands, Keyboard, 
Procedures. 

Select the MCA Manager window, then press the F1 key. The 
Help window appears, displaying information relevant to the 
MCA Manager. Maximize the Help window.  Note that the 
abbreviation MCA is underlined with a dotted line. This indicates 
a defined term. Move the cursor over the word MCA. Note that 
the cursor turns to an index. Click the mouse, and the definition 
is displayed as a pop-up definition. Click again, and the pop-up 
disappears. Now move down to terms with a solid underline. 
These represent Hypertext jumps, which means that selecting 
such an item by a single click will send you to another topic. Try 
Computing Area Spectra. You can come back to the previous 
topic using the Back pushbutton above the help text. 

You can also print any topic by using the Print Topic command in 
the File menu of the Help window. 

Display the Preferences dialog box by pulling down the File 
menu and selecting Preferences. Press the Help pushbutton. 
Maximize the Help window and scroll through the information. 
There is such a Help pushbutton in most dialog boxes in 
PolyView2000. 

Try a keyword search. Press the Index button in the Help 
window, and start typing a keyword, for example Purity. Note that 
as you enter more characters, a list of keywords is scrolled to the 
point where it best matches what you requested. 
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The Keyword Search Dialog Box 

Now select one of the keywords and press the Display button 
inside the dialog box (or press the Enter key). 

Quantitative Analysis by MCA 
Multicomponent Analysis is a proven technique, routinely used in 
spectrophotometry to determine the composition of a mix of 
known components in unknown amounts. In PolyView2000, an 
original adaptation of the technique provides easy quantitative 
analysis of groups of up to six overlapping peaks, regardless of 
the chromatographic resolution (J. Chrom, 631 (1993) 15-21). 

This requires that the components have different enough 
spectra. If this is not the case, the report will let you know. The 
one-page MCA report provides amounts, peak profiles, and an 
evaluation of the quality of the decomposition. MCA can be 
invoked interactively or under automation. 

In PolyView2000, you can also define a peak as an internal 
standard to refine the quantitation results. This process is 
documented in On-Line Help and is only available in the non-
interactive MCA report. You can obtain such reports interactively 
by using the PolyView2000 Reports window to create and 
display a report including MCA commands specifying the use of 
the Internal Standard. 
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Tutorial: Using the MCA Window for Quantitative Analysis 
Create an MCA window, using the New... command in the 
Windows menu. The MCA window will automatically fill up the 
PolyView2000 workspace. 

 
The MCA Window 

Pull down the File menu and select Open File. Select 
DIPA3020.RUN in the EXAMPLES directory. A chromatogram is 
displayed on the bottom half of the window. It contains one major 
peak of DIQUAT, which we will use as a reference. 
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To integrate this peak, press the Define Spectrum pushbutton. 
Click in front of the peak, on the peak start marker at about 1.8 
minutes, then double-click on the peak end marker at about 3.3 
minutes. This defines integration limits and baseline correction 
spectra for this peak (for more details, see On-line help on 
computing Area Spectra). A dialog box requests you to provide 
information to be saved along with this spectrum. Enter Diquat in 
the peak name field, 10 for the Amount and ug for the unit (Note 
that the flow rate was read from the file). Press OK after all the 
fields have been updated. The MCA window now shows the area 
spectrum and the integrated region is highlighted. 

 
The Amounts Dialog 
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The MCA window, showing the  

integrated region and the Area Spectrum 

Create a new library, using the Create Library command in the 
Library menu. Name it PQDQ.LBR. We will now compute area 
spectra and add them to this library. 

Add the spectrum to the library by pressing Add To Library. 

Now repeat the process with DIPA3037.RUN. The compound 
name is Paraquat, the amount 10 and the unit ug. Add the 
spectrum to the library. Create a new library, PQ.LBR, and press 
Add to Library again. At this point, you have created 2 libraries: 
PQDQ.LBR contains Paraquat and Diquat spectra, while 
PQ.LBR contains Paraquat only. 

Now repeat the integration process described in step 3 with 
DIPA3053.RUN.  This is an unknown mix, so do not enter any 
values in the Amount and Unit fields. Instead, just press OK. 

PolyView2000TM 95 



Pull down the Library menu and select Open Library. Select 
PQDQ.LBR. 

Press the MCA button. Press OK in the dialog box requesting 
additional parameters. This displays an MCA Report in a 
Preview window. This report has 3 main components: the 
Spectrum Analysis, the Plot Analysis and the Error Analysis. You 
can use the mouse to zoom in on a particular region of the 
report. To do this click on the left mouse button and drag to 
highlight the area of interest.  Double-click to restore. Note that 
the right half of the Spectrum Analysis provides quantitative 
results, while the right half of the Plot Analysis provides 
qualitative results such as retention times and resolution. The 
Error Analysis compares the residual error in each point of the 
chromatogram to the noise. See On-Line Help, Interpreting MCA 
reports for more details. Press Print Page if you want to obtain a 
hardcopy, then Delete Page to terminate the Preview. 

 
The MCA Report Parameters 

NOTE: The MCA process uses up to six spectra from the library which match 
the specified time range. If more than six spectra fit in the range, only the 
closest to the center of the range are used. As all component spectra 
must be independent, avoid placing multiple copies of the same 
spectrum in a library.  
 
When only one component is specified, the best match in the time range 
is determined based on spectral comparison, not retention time. 

96 03-914774-00:4 



OPERATION 
TUTORIAL: USING THE MCA WINDOW FOR QUANTITATIVE ANALYSIS 

 
MCA report in the absence of unexpected impurities 

Now select Library PQ.LBR (Library: Open Library), which 
contains only Paraquat, and press MCA. Press OK, and observe 
the resulting report. The MCA process fails to account for all of 
the fused pair of peaks, since not all components were in the 
library. The Error plot indicates the location and the peak profile 
of the impurity, which greatly exceeds the noise level. The 
quantitation of the compound that was present, Paraquat was 
correct as the amount in the mixture was 10 ug. The MCA 
process is able to detect any significant variation in the spectra. 
Close the preview window. 
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MCA Report showing major impurity 

Tutorial: Automating the Quantitative Analysis 
Create a Report window using the New Reports Window 
command from the Windows menu. Pull down the Reports 
menu, select Edit Method, and press New Method. Click on OK 
in the dialog box to get to the Method Builder Application.  In the 
Method Builder Application, set the report type to 
Multicomponent Analysis by pressing the Add button and 
selecting Multi-Component Analysis. Your screen should look 
like the figure below after you select the PQDQ.lbr. 
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The MCA Report Window in the Method Builder 

Set the peak time range to 1.5 to 5 minutes and the wavelength 
range to 219 to 366nm and the Plot wavelength to 254nm. Select 
Done, save the method as MCA.MTH and close the Method 
Builder application. 

In the Reports window, pull down the Reports menu and select 
Create Report. Select file DIPA3053, method MCA.MTH, and set 
the report name to MCA.SRP. The report produced is very 
similar to the one obtained interactively. Close the Report 
window. 

Note that unlike the interactive MCA, in which you decide how to 
integrate the peak, the automated MCA process relies on the 
PolyView2000 Peak Sensing for the determination of the peak 
start and end. Bad peak sensing would result in poor MCA 
analyses. See Peak Sensing on page 109. 
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Purity Evaluation by MCA 
In the absence of reference spectra, a peak can be analyzed by 
MCA on its average spectrum, its Apex spectrum, or a heart cut 
based on a height threshold. This is used to assess Peak Purity. 
The Error Analysis portion of the Purity Report will report  any 
significant fluctuation of the shape of the spectrum across the 
peak. 

Tutorial: Using the MCA Window to Evaluate Purity 
In the MCA window, open file DIPA3053.RUN. Integrate the 
peak as described in previous tutorials, then press Purity. A 
dialog box lets you choose options for the Purity Report. The 
purpose of the second and third options is to avoid lumping in 
too much baseline noise in the reference spectrum, which might 
be a problem at low levels or with a long tailing peak. When you 
select Whole Peak Area, the resulting report analyzes the peak 
on its average spectrum. The Error Analysis plot will show 
whether or not the peak is spectrally homogeneous. Print the 
report if desired and close the Preview window. 
 

 
Purity Report Parameters 

For more information, see On-Line Help on Interpreting MCA 
Reports. 

Note that you should use this feature to check that a reference 
spectrum comes from a pure peak PRIOR to adding it to a 
library. Always screen your standards in this manner prior to 
adding them to a library. 
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MCA Purity Report 

The Purity Report can also be produced under automation. 
Select Purity Analysis as the report type in the Method Builder. 

In PolyView2000, a computation of molar extinction coefficients 
has been added as an option to the Purity Report. Based on a 
chromatographic run, this feature provides in a single step the 
determination of the extinction coefficients at all wavelengths 
monitored and documents the purity (or impurity!) of the sample. 
Search On-Line Help for ‘Extinction Coefficient’. 
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Creating Workstation Channels 
You can create a reduced file containing 1 to 5 channels of time-
programmed absorbance data, and full spectra for the original 
peak events. 

 A reduced file will take up much less storage space than a 
complete diode array file. Also, a reduced file will allow the 
workstation software to process one of more chromatograms 
where the processed wavelength changes during the run. 
Usually only the monitor channel data will be automatically 
processed by the data handling on the workstation. 

In the 9065, the workstation channelsreplace the original data, 
as it does not have full spectral data for each time point on the 
chromatogram. It does have enough data to calculate the purity 
parameter on the upslope, peak apex and downslope as well as 
do library searches and spectral comparisons. It does not have 
enough data to do MCA quantitation or the peak purity survey. 
for 330 data, the workstation channels are stored independently 
of the spectral data. You still have the option of deleting the 
spectral data if reducing file size is desired. 

To create workstation channels, pull down the File menu item 
and select Create workstation channels. 

 

 
Edit workstation channels dialog box. 
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By default, the first and only channel is defined by the current 
peak sensing tune program. The other four channels can be time 
programmed using the button. Once this is programmed, using 
the Create Reduced Channels button creates a file containing 
the reduced channels.  

The file name used for the reduced channels is derived from the 
original filename by appending :”_bkup” to the filename, e.g., 
mydata.run will be saved as mydata_bkup.run. In order to save 
the original file with all of the spectral data, check the Save 
Backup check box. This will rename the existing file with the 
extension run-bkup. This file can be reprocessed as any other 
diode array file. 

PolyView2000TM 103 





 

Library Searches 

The advanced spectral searching capabilities in PolyView2000 
allow you to match unknown spectra from eluting peaks with 
spectra stored in a spectral library. This provides valuable 
information for confirmation of peak identity. The spectral 
similarity indices provided during the library search along with 
retention time information can be used to quantify the degree of 
confidence in identifying the unknown peak. With a little 
experience, you will be able to develop criteria based on your 
particular application for the identification of eluting peaks based 
on these indices. 

Library searches in PolyView2000 are quite flexible, allowing the 
user to establish a number of criteria to narrow down the search. 
Prior to conducting the search, you are allowed to set windows 
for retention time, Purity Parameter (PuP) and dissimilarity within 
which the search will be conducted. For instance, if you are 
using the exact same method for the analysis of unknowns as for 
the standards from which the library was built, you may decide 
that the unknowns should have the same retention time (±10%) 
as the standards. You would then set a relative retention time 
tolerance of 0.1. For Non-interactive reports, set the Relative 
Time field to 0.9-1.1 and for Interactive searches set the search 
window to ±10% of the retention time of the target spectrum. 
Similarly, a Purity Parameter window can be defined. When a 
library search is conducted, PolyView2000 considers all those 
spectra in the search libraries that are within the retention time 
and Purity Parameter windows. Those spectra meeting these 
first two criteria are considered as possible matches and 
similarity and dissimilarity indices are computed. Matches 
exceeding the dissimilarity threshold are discarded. They are 
then ranked according to the similarity index and the best five 
are listed in the report (except the short reports, where only the 
best match is reported).  
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The figure below illustrates the processes involved in conducting 
a library search for a spectrum in PolyView2000. 

The similarity and dissimilarity indices are the primary means of 
assessing the degree of match between the target and library 
spectra. There are a wide variety of factors that can influence the 
match quality. Listed below are a number of factors that can lead 
to poor spectral matches in PolyView2000: 

• Spectral shifts due to solvent differences (pH, ionic strength, 
type of solvent, etc.). 

• Concentration differences between the target spectrum and 
library spectra. 

• Chromatographic noise at low S/N ratios. 

• Co-eluting compounds within the analyte peak 

• Inaccuracies in the gradient composition and/or badly 
sloping baselines during gradient separations. 

• Spectral characteristics of the analyte (i.e., presence or 
absence of unique features in the UV spectra). 
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PolyView2000 Library Searches 
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Following the library search, the degree of match is quantified 
from the similarity and dissimilarity. It is up to the user to 
establish guidelines unique to their particular application for the 
interpretation of the match criteria presented. The statistics 
report obtained from the Spectra Manager window can be used 
to assist the user in formulating guidelines for similarity and 
dissimilarity values, by providing the PuP mean and standard 
deviation, as well as the best and worst similarity and 
dissimilarity for a set of spectra. Using these computations, you 
can determine the degree of expected correlation for your 
particular application. Then, based on these numbers, you can 
set up the library search parameters to best meet your needs. 

Under routine conditions, the following table can be used as a 
guide for interpreting similarity and dissimilarity values in library 
searches. Keep in mind that a number of factors can lead to 
poorer match indices for identical peaks. You should qualify the 
expected values based on your particular application, using the 
statistical functions in the Spectral Manager window. 

 
Table 1 Library Matches in PolyView2000 

Match Quality Similarity Range Dissimilarity Range 

Good 1.0 - 0.998 0.0 - 0.06 

Poor 0.998 - 0.980 0.06 - 0.20 

Bad <0.980 >0.20 

Note that in the MCA reports, the goodness of fit is compared to 
a predicted threshold deduced from the monitored noise values. 
Search for “Interpreting MCA Reports” in the On-Line Help to 
obtain the detail of the algorithm use. The On-Line Help also 
details how to customize the match criteria and disable the 
good/poor/bad match estimation made by the software. 
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Peak Sensing 

 
A number of functions in PolyView2000 require an accurate 
means of detecting the presence of peaks in a chromatogram. It 
is the function of the Peak Sensing algorithm to determine the 
profile of the baseline and the presence of peaks on the 
baseline. The peak sensing in PolyView2000 is separate from 
the Workstation's peak sensing due to the different needs of the 
two programs. For peak sensing, the user must specify the 
wavelength (or range) to be considered, the peak width (in 
seconds at half height) and the desired threshold (expressed as 
a S/N ratio). All of these parameters are time-programmable to 
meet the changing characteristics of the data file. Keep in mind 
that, unlike peak sensing in the Data Handling application of the 
Workstation, peak width in PolyView2000 is not updated 
automatically and updates must be time programmed into the 
peak sensing method. This Peak Sense Time Program is built in 
the Method Builder program and then used to perform the peak 
sensing function either interactively in PolyView2000's Peak 
Sense window or non-interactively under the System 
Control/Automation program. If the peak sensing parameters 
have been properly set, accurate peak detection will result. For 
many applications, you may find that the following peak sensing 
program gives adequate peak detection: 

Wavelength: 220-367 nm 

Peak Width: either 4 or 8 sec 

S/N: either 5 or 10 
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The best indication as to the accuracy of the peak sensing (and 
therefore the appropriateness of the method used) is the location 
of the peak event markers in the chromatogram. The Peak Apex 
events should be accurately placed at the true apex, the upslope 
and downslope events should be approximately midway along 
the peak and the peak start and end points should be in the flat 
portion of the baseline immediately adjacent to the peak. Often, 
the peak width parameter doesn't have to be set exactly for 
accurate peak event placement. Also, since peak events in 
PolyView2000 are used only to perform baseline corrections of 
spectra, not to compute peak areas, only peak start and peak 
end events are critical.  

Most of the time, you will find that, if the peak width is set to the 
width at half height of your chromatographic peaks and a 
reasonable S/N value is set (use S/N=5 whenever possible), 
peak event placement will be similar to the figure below. In some 
situations, such as sloping baselines and/or very small peaks 
relative to noise, you may find that events are not placed 
correctly. In these situations, you will need to experiment with 
different peak sensing programs until you find one suitable for 
your particular application. Table 2 Peak Sense Troubleshooting  
can be used as a guide in troubleshooting peak sensing in 
PolyView2000. Following are two examples illustrating poor peak 
sensing results and the required change in the peak sensing 
program to improve the results. Keep in mind that the noise 
values calculated from the diode array run monitor data can 
influence peak sensing and, if corrupted, may need to be 
recalculated using the Define User Monitor function. The Peak 
Sense window displays the value of the noise in arbitrary units.  
Noise values above 2 usually indicate a problem. For more 
information, search On-Line Help for 'Troubleshooting'. 

Note that the Inhibit Integrate event (II) can be used to inhibit 
peak retention during a portion of the chromatogram. 
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PEAK SENSING  

Table 2 Peak Sense Troubleshooting 

Condition Symptom Solution 
S/N set correctly (usually 5) Misplaced peak events. 

Inflections are significantly 
below 60% of the peak 
height on a symmetrical 
peak. 

Use smaller peak width 

S/N set correctly (usually 5) Peaks not detected. Use larger peak width. 
Peak width set to width at 
1/2 height. 

Small peaks not 
detected. 

Use smaller S/N 

Peak width set to width at 
1/2 height. 

Many peaks events 
found in baseline. 

Use larger S/N 

 

Correct Placement of Peak Sensing Events 
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Effect of an excessive width setting 
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PEAK SENSING  

 
Effect of a too small S/N setting 
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Aurora 

Aurora displays and prints isoabsorbance curves for diode array 
data files. The figure below shows a typical monochrome output 
for Aurora. Color output is supported on qualified printers 
(consult you sales representative). Aurora is installed in the Star 
folder as part of the PolyView2000 installation. A diode array file 
can be opened into Aurora using the file menu.  

 
Aurora Report, Exported 
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Aurora has three windows, a chromatogram window at the top of 
the display, an isogram window in the center and a spectrum 
window on the bottom.  These Windows can be sized by moving 
the bars that separate the three windows.  

A chromatogram and spectrum for display are chosen by moving 
the cursor to the wavelength and time that you would like to 
display and right clicking the mouse. Many different 
chromatograms and spectra can be selected by right clicking on 
different points of the display.  The existing chromatograms and 
spectra can be moved “grabbing” either the horizontal or vertical 
lines with the cursor by left clicking the mouse while the “hand” is 
on that particular line. 

The color intensities on the isogram are scaled logarithmically.  
The colors can be changed and can be set to gray scale to more 
easily see the result of printing the isogram on a monochrom 
printer. 
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Appendix A 

PolyView2000 produces a wide variety of printed reports, as 
most data processing functions can be documented by means of 
a printed report. The reports generated one at the time while you 
are working at the Workstation are termed Interactive Reports. 
The reports obtained in an unattended, automated fashion, as 
the result of the execution of a method are called Non-
Interactive Reports. Both types of reports can be annotated in 
color if printed on a color printer such as the HP 600/700/800 or 
900 series color printers. In general, the colors that you see on 
the screen will be reproduced on the page, with the exception of 
yellow and white which may be printed in black. Of course, if you 
don't have a color printer available, the prints are produced in 
black and white. The reports have been designed so no 
information content is lost if they are printed in black and white 
only. For routine work, you may want to turn off the color option 
in the printer set-up window because usually shorter printing 
times will be achieved if the print is not in color. 

The reports on the following pages will give you an example of 
what your reports will look like.  Changes in the parameters you 
enter for the report, the number of wavelengths that you have 
collected and the version of software that you have will effect the 
report itself.  However, all of the data will be on the report. 

Interactive Reports 
This appendix lists examples of PolyView2000 Interactive 
Reports. Refer to Appendix B for examples of PolyView2000 
Non-Interactive Reports. 
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                                         Page 1 - PV_SAM01.RUN Peak Sense Log                       
 File:  c:\star\pv_sam01.run                                                     
 Name:  Sample #1                                                                
 Sample #1 with the internal standard added at Instrument: Varian LC Star 9.5 ppm.  
                                               Method:     TEST27.MTH             
                                               Operator:   MEA                    
                                               Run Date:   22-SEP-88 12:30 PM     
 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz                           
                    Original Peak Sense Time Program Method                      
               0.00 min  Peak Sense         200 - 367 nm  8 sec                  
               0.00 min  S/N Threshold      5                                    
               0.01 min  Inhibit Integrate  1.50 min                             
               3.00 min  Peak Sense         254 nm  8 sec                        
                                                                                 
                     Result Peak Sense Time Program Method                       
               0.00 min  Peak Sense         200 - 367 nm  8 sec                  
               0.00 min  S/N Threshold      5                                    
               0.01 min  Inhibit Integrate  1.50 min                             
               3.07 min  Peak Sense         254 nm  8 sec                        
                              Peak Sense Warnings                                
    3.00 min  Inside of peak, cannot make PEAK SENSE change.                     
    3.07 min  Delayed peak sense parameters change made.                         
Run Monitor:  64 spectra.                                                        
 nm       Noise      nm       Noise      nm       Noise      nm       Noise      
 --       -----      --       -----      --       -----      --       -----      
 190      6.891      239      1.138      287      1.416      335      1.717      
 195      2.295      244      1.261      292      1.641      339      2.442      
 200      1.490      249      1.171      297      1.385      344      1.768      
 205      1.622      254      1.242      302      1.301      348      2.633      
 210      1.174      259      1.312      306      1.815      353      1.828      
 215      1.235      263      1.632      311      1.739      358      2.264      
 220      1.054      268      1.622      316      1.532      362      2.730      
 224      1.145      273      1.332      321      2.013      367      2.654      
 229      1.375      278      1.203      325      1.666                          
 234      1.105      283      1.554      330      1.408                          
Events between 0.000 - 5.984 minutes.                                            
       tR (min) Events          tR (min) Events          tR (min) Events         
       -------- ------          -------- ------          -------- ------         
    1.    0.000 Baseline    13.    2.716 Peak Start  25.    3.944 Peak Apex      
    2.    1.683 Peak Start  14.    2.789 Upslope     26.    3.993 Downslope      
    3.    1.757 Upslope     15.    2.826 Peak Apex   27.    4.252 Peak End       
    4.    1.782 Fr Shoulde  16.    2.875 Downslope   28.    4.706 Peak Start     
    5.    1.843 Upslope     17.    2.998 Peak End    29.    4.915 Upslope        
    6.    1.880 Peak Apex   18.    3.010 Baseline    30.    4.977 Peak Apex      
    7.    1.917 Downslope   19.    3.232 Peak Start  31.    5.050 Downslope      
    8.    2.347 Peak End    20.    3.391 Upslope     32.    5.603 Peak Start     
    9.    2.458 Peak Start  21.    3.441 Peak Apex   33.    5.763 Upslope        
   10.    2.556 Upslope     22.    3.490 Downslope   34.    5.824 Peak Apex      
   11.    2.605 Peak Apex   23.    3.748 Peak Start  35.    5.886 Downslope      
 
 
  12.    2.642 Downslope   24.    3.883 Upslope     36.    5.984 Baseline       

Peak Sense Log Report 

Windows and Command path:  Plot Window: File: Print Peak Sense Log 
  Peak Events:  List Peak Events: Print List Button 

118 03-914774-00:4 



APPENDIX A  
INTERACTIVE REPORTS 

PolyView2000TM 119 

Plot Report

 File:  c:\star\pv_sam01.run                                                   
 Name:  Sample #1

Sample #1 with the internal standard added at
9.5 ppm.

Instrument:  Varian LC Star
Method:    TEST27.MTH
Operator:  MEA
Run Date:  22-SEP-88 12:30 PM

 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz

Absorbance at 254 nm

0

25

50

75

100

mAU

1 2 3 4 5
minutes Baseline Correction

 

Plot Report 

 
Windows and Command path: 
 Plot Window: 
  File: Print Plot 
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Peak Event Report

 File:  c:\star\pv_sam01.run                                                   
 Name:  Sample #1

Sample #1 with the internal standard added at
9.5 ppm.

Instrument:  Varian LC Star
Method:    TEST27.MTH
Operator:  MEA
Run Date:  22-SEP-88 12:30 PM

 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz

Absorbance at 254 nm

0

25

50

75

100
mAU

1 2 3 4 5
minutes Baseline Correction

Absorbance Table
nm mAU nm mAU nm mAU nm mAU nm mAU
190 211.813 229 62.279 268 165.528 306 2.231 344 1.373
195 245.728 234 52.480 273 162.186 311 1.501 348 1.596
200 276.279 239 55.891 278 144.949 316 2.098 353 1.192
205 278.452 244 66.206 283 115.750 321 1.877 358 0.690
210 226.368 249 84.260 287 78.149 325 1.967 362 1.632
215 165.596 254 108.252 292 40.820 330 2.657 367 1.483
220 108.615 259 134.642 297 16.007 335 1.658
224 66.077 263 155.326 302 5.686 339 1.242

Peak Apex at 3.441 min   PuP = 223.19 nm

200 225 250 275 300 325 350
Wavelength (nm)

0

50

100

150

200

250

mAU190 367

 

Peak Event Report 

 
Windows and Command path: 
 Plot Manager: 
  Peak Events: List Peak Events: Print Button 
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                     Page 1 - Chromatogram Search Report                        
                                                                                 
 Match  Similarity  Dissimilarity  PuP (nm)  Event       tR (min)                
 -----  ----------  -------------  --------  -----       -------                 
   1     1.00000      0.00147      229.907   Peak Apex     4.977                 
   2     0.99999      0.00508      230.039   Upslope       4.915                 
   3     0.99996      0.00948      229.685   Downslope     5.050                 
                                                                                 
                                Search Conditions                                
 PuP Range:  190->367 nm  PuP Interval: +/- 5.00 nm                              
 Time Range:  0.000 - 5.984 min                                                  
 Maximum Dissimilarity:  0.30                                                    
                                                                                 
 File:  c:\star\pv_sam01.run                                                     
 Name:  Sample #1                                                                
 Sample #1 with the internal standard added at Instrument:  Varian LC Star       
 9.5 ppm.                                      Method:    TEST27.MTH             
                                               Operator:  MEA                    
                                               Run Date:  22-SEP-88 12:30 PM     
 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz                           
                                                                                 
                                 Search Spectrum                                 
 File:  c:\star\pv_sam01.run                                                     
 tR:  4.964 min   PuP (190->367 nm) = 229.941 nm                                 
 Name:  Sample #1                                                                
 Sample #1 with the internal standard added at Instrument:  Varian LC Star       
 9.5 ppm.                                      Method:    TEST27.MTH             
                                               Operator:  MEA                    
                                               Run Date:  22-SEP-88 12:30 PM     
 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz                           
 Detector Range:  190->367 nm       Valid Range:  190->367 nm                    
 Spectrum Type:  Within Peak        Correction Type:  Baseline                   
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Chromatogram Search Report

Search Conditions
 PuP Range:  200->367 nm  PuP Interval: +/- 5.00 nm
 Time Range:  0.000 - 5.984 min

 File:  c:\star\pv_sam01.run                                                   
 Name:  Sample #1

Sample #1 with the internal standard added at
9.5 ppm.

Instrument:  Varian LC Star
Method:    TEST27.MTH
Operator:  MEA
Run Date:  22-SEP-88 12:30 PM

 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz

Search Spectrum, Scaled by 1.780
 File:  c:\star\pv_sam01.run                                                   
 tR:  4.915 min   PuP (200->367 nm) = 232.289 nm
 Name:  Sample #1

Sample #1 with the internal standard added at
9.5 ppm.

Instrument:  Varian LC Star
Method:    TEST27.MTH
Operator:  MEA
Run Date:  22-SEP-88 12:30 PM

 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz
 Detector Range:  190->367 nm       Valid Range:  190->367 nm
 Spectrum Type:  Upslope            Correction Type:  Baseline

Absorbance at 254 nm

0

25

50

75

mAU

1 2 3 4 5
minutes Baseline Correction

Match #2 of 3 Matches   Similarity:  0.99998   Dissimilarity:  0.00620
Peak Apex at 4.977 min   PuP = 232.17 nm

200 225 250 275 300 325 350
Wavelength (nm)
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-0.50

0.00
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Chromatogram Search Report (Graphics) 

 
Windows and Command path: 
 Plot Manager: 
  Peak Events: Search Peak Events: Print button 
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Spectrum Plot Report

Spectrum # 4
 File:  c:\star\pv_sam01.run                                                   
 tR:  4.915 min   PuP (220->367 nm) = 250.657 nm
 Name:  Sample #1

Sample #1 with the internal standard added at
9.5 ppm.

Instrument:  Varian LC Star
Method:    TEST27.MTH
Operator:  MEA
Run Date:  22-SEP-88 12:30 PM

 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz
 Detector Range:  190->367 nm       Valid Range:  190->367 nm
 Spectrum Type:  Upslope            Correction Type:  Baseline

Absorbance Table
nm mAU nm mAU nm mAU nm mAU nm mAU
190 25.477 229 24.390 268 2.814 306 6.545 344 10.252
195 28.564 234 23.720 273 1.668 311 7.507 348 10.486
200 39.176 239 30.309 278 1.921 316 8.251 353 10.286
205 53.610 244 41.639 283 2.387 321 8.533 358 9.661
210 59.877 249 52.034 287 2.882 325 8.370 362 8.409
215 51.435 254 51.633 292 3.629 330 8.489 367 6.976
220 38.055 259 33.165 297 4.512 335 9.085
224 30.304 263 11.309 302 5.553 339 9.789

Channel Range: 220 to 367 nm    Absorbance Range: 1.6685 to 52.034 mAU

Max Wavelength (nm): 251.02 321.13 348.48
Percent Max Abs.: 102.2% 16.4% 20.2%

Upslope at 4.915 min   PuP = 250.66 nm

200 225 250 275 300 325 350
Wavelength (nm)
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Spectrum Plot Report (Single)  

 
Windows and Command path: 
 Spectra Manager: 
  Spectrum: Print Spectra (single displayed) 
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Spectral Overlay Report

No. Name PuP (nm) tR (min) Spectrum Type Correction Filename
2 Sample #1

233.730    3.944 Peak Apex Baseline PV_SAM01.RUN
3 Sample #1

250.615    4.964 Within Peak Baseline PV_SAM01.RUN
4 Sample #1

262.414    2.580 Within Peak Baseline PV_SAM01.RUN

200 225 250 275 300 325 350
Wavelength (nm)

0

25

50

75

mAU220 367

 

Spectrum Plot Report (Multiple)  

 
Windows and Command path: 
 Spectra Manager: 
  File: Print Spectra (multiple spectra displayed)  
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                     PuP Statistics Report                               
                                                                                 
No  Filename  tR (min) Spectrum Type Correction PuP (220->367 nm)                
--  --------  -------- ------------- ---------- -----------------                
1 PV_SAM01.RUN   4.903  Within Peak   Baseline   250.593                         
2 PV_SAM01.RUN   4.940  Within Peak   Baseline   250.645                         
3 PV_SAM01.RUN   4.977  Peak Apex     Baseline   250.597                         
4 PV_SAM01.RUN   5.001  Within Peak   Baseline   250.617                         
5 PV_SAM01.RUN   5.026  Within Peak   Baseline   250.581                         
6 PV_SAM01.RUN   5.063  Within Peak   Baseline   250.633                         
Best Correlation:   4 and 5   Sim:  0.999996   Dissim:  0.002719                 
Worst Correlation:  1 and 6   Sim:  0.999878   Dissim:  0.015613                 
Average PuP = 250.611 nm    Standard Deviation = 0.023 nm                        
                                                                                 
Target:                                                                          
PuP:  250.611 nm                                                                 
No  Filename  tR (min) Spectrum Type Correction PuP (220->367 nm)                
--  --------  -------- ------------- ---------- -----------------                
1 PV_SAM01.RUN   4.903  Within Peak   Baseline   250.593 (-0.018 nm)             
2 PV_SAM01.RUN   4.940  Within Peak   Baseline   250.645 (+0.034 nm)             
3 PV_SAM01.RUN   4.977  Peak Apex     Baseline   250.597 (-0.014 nm)             
4 PV_SAM01.RUN   5.001  Within Peak   Baseline   250.617 (+0.006 nm)             
5 PV_SAM01.RUN   5.026  Within Peak   Baseline   250.581 (-0.030 nm)             
6 PV_SAM01.RUN   5.063  Within Peak   Baseline   250.633 (+0.022 nm)             
Best Correlation:   4 and 5   Sim:  0.999996   Dissim:  0.002719                 
Worst Correlation:  1 and 6   Sim:  0.999878   Dissim:  0.015613                 
Average PuP = 250.611 nm    Standard Deviation = 0.023 nm                        
                                                                                 
Target:                                                                          
PuP:  250.611 nm    Standard Deviation:  0.002 nm                                
No  Filename  tR (min) Spectrum Type Correction PuP (220->367 nm)                
--  --------  -------- ------------- ---------- -----------------                
1 PV_SAM01.RUN   4.903  Within Peak   Baseline   250.593 (-7.80 SD)              
2 PV_SAM01.RUN   4.940  Within Peak   Baseline   250.645 (+14.86 SD)             
3 PV_SAM01.RUN   4.977  Peak Apex     Baseline   250.597 (-6.12 SD)              
4 PV_SAM01.RUN   5.001  Within Peak   Baseline   250.617 (+2.77 SD)              
5 PV_SAM01.RUN   5.026  Within Peak   Baseline   250.581 (-13.07 SD)             
6 PV_SAM01.RUN   5.063  Within Peak   Baseline   250.633 (+9.71 SD)              
Best Correlation:   4 and 5   Sim:  0.999996   Dissim:  0.002719                 
Worst Correlation:  1 and 6   Sim:  0.999878   Dissim:  0.015613                 
Average PuP = 250.611 nm    Standard Deviation = 0.023 nm                        
 

PuP Statistics Report 

 
Windows and Command path: 
 Spectra Manager: 
  Spectrum: Do statistics: Print Button 
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Page 1 - pv_std01.lbr Library Index Report                    
                                                                    
 File:  c:\star\pv_std01.lbr                                        
 Name:  Test Fractions                                              
 Note:  Contains spectra from PV_STD01.RUN                        
 Operator:  MEA                                                    
 Last Modified:  14-MAR-94 2:34 PM                                 
                                                                  
  No. tR (min) Filename     Name                                   
  --- -------- ------------ ----                                   
   1.    1.888 PV_STD01.RUN Trimonreal                            
   2.    2.825 PV_STD01.RUN Dimonreal                               
   3.    3.430 PV_STD01.RUN AS-98                                   
   4.    3.948 PV_STD01.RUN AH-187                                 
   5.    4.997 PV_STD01.RUN AJ-65                                  
   6.    5.848 PV_STD01.RUN AS-96  

Library List Report 

 
Windows and Command path: 
 Library Manager: 
  File: Print Library Index 
  Library: Select/Edit Library Records: Print button 



APPENDIX A  
INTERACTIVE REPORTS 

PolyView2000TM 127 

 Page 1 - Library Search Report                          
                                                                                 
 Matches:                     Sim.    Dissim. PuP(nm) tR(min) Lib #              
 --------                     ------- ------- ------- ------- --- -              
 AJ-65                        0.99997 0.00735 232.282   4.997  A  5              
                                                                                 
                                Search Conditions                                
 PuP Range:  200->367 nm  PuP Interval: +/- 5.00 nm                              
 Time Range:  0.000 - 1440.000 min                                               
 Maximum Dissimilarity:  0.30                                                    
                                                                                 
 Libraries:                                                                      
 A:  c:\star\pv_std01.lbr                                                        
                                                                                 
                                 Search Spectrum                                 
 File:  c:\star\pv_sam01.run                                                     
 tR:  4.964 min   PuP (200->367 nm) = 232.198 nm                                 
 Name:  Sample #1                                                                
 Sample #1 with the internal standard added at Instrument:  Varian LC Star       
 9.5 ppm.                                      Method:    TEST27.MTH             
                                               Operator:  MEA                    
                                               Run Date:  22-SEP-88 12:30 PM     
 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz                           
 Detector Range:  190->367 nm       Valid Range:  190->367 nm                    
 Spectrum Type:  Within Peak        Correction Type:  Baseline                   
                                                                                 
                                Possible Match #1                                
 File:  c:\star\tutorial\pv_std01.run                                            
 tR:  4.997 min   PuP (200->367 nm) = 232.282 nm                                 
 Name:  AJ-65                                                                    
 Test fraction @ 10.0 ppm.                     Instrument:  Varian LC Star       
                                               Method:    TEST27.MTH             
                                               Operator:  MEA                    
                                               Run Date:  22-SEP-88 12:30 PM     
 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz                           
 Detector Range:  190->367 nm       Valid Range:  200->367 nm                    
 Spectrum Type:  Peak Apex          Correction Type:  Baseline                   
 

Library Search Report (Text)  

 
Windows and Command path: 
 Library Manager: 
  Search: Search for Spectrum: Search button: Print List button 
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Library Search Report

Search Conditions
 PuP Range:  220->367 nm  PuP Interval: +/- 5.00 nm
 Time Range:  0.000 - 1440.000 min

Search Spectrum
 File:  c:\star\pv_sam01.run                                                   
 tR:  4.964 min   PuP (220->367 nm) = 250.615 nm
 Name:  Sample #1

Sample #1 with the internal standard added at
9.5 ppm.

Instrument:  Varian LC Star
Method:    TEST27.MTH
Operator:  MEA
Run Date:  22-SEP-88 12:30 PM

 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz
 Detector Range:  190->367 nm       Valid Range:  190->367 nm
 Spectrum Type:  Within Peak        Correction Type:  Baseline

Spectrum of Possible Match, Scaled by 1.237
 File:  c:\star\tutorial\pv_std01.run                                          
 tR:  4.997 min   PuP (220->367 nm) = 250.656 nm
 Name:  AJ-65

Test fraction @ 10.0 ppm. Instrument:  Varian LC Star
Method:    TEST27.MTH
Operator:  MEA
Run Date:  22-SEP-88 12:30 PM

 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz
 Detector Range:  190->367 nm       Valid Range:  200->367 nm
 Spectrum Type:  Peak Apex          Correction Type:  Baseline

Match #1 of 1 Matches   Similarity:  0.99997   Dissimilarity:  0.00821
Record #5 of c:\star\pv_std01.lbr                                        

Peak Apex at 4.997 min   PuP = 250.66 nm
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Library Search Report (Graphics)  

 
Windows and Command path: 
 Library Manager: 
  Search: Search for Spectrum: Search button: Print Match button 
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Peak Sense Plot Report

 File:  c:\star\pv_sam01.run                                                   
 Name:  Sample #1

Sample #1 with the internal standard added at
9.5 ppm.

Instrument:  Varian LC Star
Method:    TEST27.MTH
Operator:  MEA
Run Date:  22-SEP-88 12:30 PM

 Scan Rate:  10.851 Hz  Bunch: 8  Data Rate:  1.356 Hz
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II
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II
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Peak Sense Wavelengths

 

Peak Sense Plot Report 

 
Windows and Command path: 
 Peak Sense Manager: 
  File: Print Plot 
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 File:  c:\star\tutorial\dipa3053.run Rpt Date:  28-JUN-94 9:30 PM
 Name:  0.01D/0.1P
 Instrument:  Varian Star
 Method:    pq.mth
 Operator:  Number 1
 Run Date:  3-MAR-92 10:40 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

MCA Report - External Standard Analysis

Baseline:  1.757 min (average of 5) to 3.502 min (average of 5)
Integration:  1.757 to 3.502 min,  Flow Rate:  2.000 ml/min (Pump Log)
Library:  c:\star\pqcalhi.lbr

Spectrum Analysis over 229-367 nm
excluding 335-367
Lib Name Amount
Index

#1 Paraquat 9.89 ug
#2 Diquat 0.91 ug

Similarity: 1.00000
Dissimilarity: 0.00072 (0.001352)

Search window: 1.757 to 3.502 min
Spectra in library: 2
Spectra in search window: 2
Components allowed: 6
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Plot Analysis at 287 nm

Lib tR Height Width Res
Index (min) mAU (sec)

#2 2.014 4.67 8.9 ---
#1 2.286 39.89 12.6 0.90

Error Analysis over 229 - 367 nm

The maximum error 40 uAU
at 2.291 minutes DOES NOT EXCEED
the noise threshold 80 uAU.
The ratio of maximum to expected
error is 0.487.

 

Multicomponent Analysis Report 

 
Windows and Command path: 
 MCA Manager: 
  MCA button 
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 File:  c:\star\tutorial\dipa3053.run Rpt Date:  28-JUN-94 9:31 PM
 Name:  0.01D/0.1P
 Instrument:  Varian Star
 Method:    pq.mth
 Operator:  Number 1
 Run Date:  3-MAR-92 10:40 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

Purity Analysis Report

Baseline:  1.757 min (average of 5) to 3.502 min (average of 5)
Integration:  1.757 to 3.502 min
Reference Spectrum:  Whole Peak Area

Spectrum Analysis over 229-367 nm
excluding 325-367
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Plot Analysis at 287 nm

tR Height Width
(min) mAU (sec)
2.286 42.32 12.6

Error Analysis over 229 - 367 nm

The maximum error 6 mAU
at 2.012 minutes EXCEEDS
the noise threshold 0.08 mAU.
The ratio of maximum to expected
error is 67.004.

 

Purity Analysis Report 

 
Windows and Command path: 
 MCA Manager: 
  Purity button 
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 File:  c:\star\pitcon94\p94012.run Rpt Date:  28-JUN-94 9:29 PM
 Name:  DiNitroPhenol
 Instrument:  LC System Research
 Method:    ISOCRAT.MTH
 Operator:  Chris Kellogg
 Run Date:  18-FEB-94 6:05 PM
 Scan Rate:  10.851 Hz   Bunch:  4   Data Rate:  2.713 Hz

Molar Extinction Coefficient Report:  Dinitrophenol

Baseline:  2.482 min (average of 5) to 3.146 min (average of 5)
Integration:  2.482 to 3.146 min
Reference Spectrum:  Region above 50.00% of Apex, 2.599 to 2.716 min

Spectrum Analysis over 229-367 nm

Flow Rate: 1.000 ml/min (Pump Log)
Path Length: 0.60 cm
Amount: 0.0012 micromole

E ( 254 nm ) = 3580 /M·cm

Emax ( 273.5 nm ) = 6130 /M·cm
Emax ( 346.3 nm ) = 3160 /M·cm

Reference vs. Whole Area Spectrum
Similarity: 0.99996
Dissimilarity: 0.00941
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Plot Analysis at 254 nm

tR Height Width
(min) mAU (sec)
2.650 20.80 6.7

Error Analysis over 229 - 367 nm

The maximum error 2e+002 uAU
at 2.962 minutes DOES NOT EXCEED
the noise threshold 5e+002 uAU.
The ratio of maximum to expected
error is 0.347.

 

Extinction Coefficient Report 

 
Windows and Command path: 
 MCA Manager: 
  Purity button 

  (Extinction Coeff. computation is enabled in Options:Report Options) 
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Appendix B 

PolyView2000 produces a wide variety of printed reports, as 
most data processing functions can be documented by means of 
a printed report. The reports generated one at the time while you 
are working at the Workstation are termed Interactive Reports. 
The reports obtained in an unattended, automated fashion, as 
the result of the execution of a method are called Non-
Interactive Reports. Both types of reports can be annotated in 
color if printed on a color printer such as the Canon BJC-600. In 
general, the colors that you see on the screen will be reproduced 
on the page, with the exception of yellow and white which may 
be printed in black. Of course, if you don't have a color printer 
available, the prints are produced in black and white. The reports 
have been designed so no information content is lost if they are 
printed in black and white only. For routine work, you may want 
to turn off the color option in the printer set-up window because 
usually shorter printing times will be achieved if the print is not in 
color. 

Non-Interactive Reports 
This appendix lists examples of PolyView2000 Non-Interactive 
Reports. Refer to Appendix A for examples of PolyView2000 
Interactive Reports. 
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 File:  c:\star\tutorial\pv_sam01.run Rpt Date:  28-JUN-94 7:04 PM
 Name:  Sample #1
 Sample #1 with the internal standard added at Instrument:  Varian LC Star
 9.5 ppm. Method:    TEST27.MTH
 Operator:  MEA
 Run Date:  22-SEP-88 12:30 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

Absorbance:  254 nm

1 2 3 4 5
minutes

0

25

50

75

100

mAU

 

Single Plot Report 
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 File:  c:\star\tutorial\pv_sam01.run           Rpt Date:  28-JUN-94 7:04 PM     
 Name:  Sample #1                                                                
 Sample #1 with the internal standard added at  Instrument:  Varian LC Star      
 9.5 ppm.                                       Method:    TEST27.MTH            
                                                Operator:  MEA                   
                                                Run Date:  22-SEP-88 12:30 PM    
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz                        
------------------------------------------------------------------------------ 
 General Table Report - Page 1                                                   
 Events between 0.000 and 5.984 minutes                                          
                      Absorbance   Max Absorbance     Purity          Ratio      
                      254->254 nm    220->367 nm    220->367 nm    254->254 nm   
   Time    Event         mAU            mAU             nm        /224->224 nm   
  ------ ----------   -----------    -----------    -----------    -----------   
   1.683  PeakStart     -0.793         -0.504         *****          *****       
   1.757  Upslope        0.191          8.548        223.598         0.1581      
   1.782  FShoulder     10.315         19.907        273.197         0.6449      
   1.843  Upslope       16.836         40.884        262.922         0.5032      
   1.880 Peak Apex      44.607        105.878        263.670         0.5102      
   1.917  Downslope     10.167         25.140        263.314         0.5058      
   2.347  Peak End      -0.076          0.000         *****          *****       
   2.458  PeakStart     -0.076          0.229         *****          *****       
   2.556  Upslope        8.542         11.337        262.413         1.5995      
   2.605 Peak Apex      41.284         54.427        262.415         1.6018      
   2.642  Downslope     10.063         13.318        262.416         1.6010      
   2.716  PeakStart     -0.040          0.313         *****          *****       
   2.789  Upslope        6.495          9.592        247.354         1.1924      
   2.826 Peak Apex      18.198         26.732        247.367         1.1909      
   2.875  Downslope      5.050          7.538        247.343         1.1851      
   2.998  Peak End      -0.114          0.000         *****          *****       
   3.232  PeakStart     -0.122          0.267         *****          *****       
   3.379  Upslope       37.678         74.099        261.460         1.0250      
   3.428 Peak Apex     106.050        168.610        262.114         1.3294      
   3.477  Downslope     63.600         91.466        262.351         1.4825      
   3.760  PeakStart     -0.021          0.153         *****          *****       
   3.883  Upslope        9.200         38.892        230.608         0.4120      
   3.932 Peak Apex      21.791         75.919        233.044         0.5024      
   3.993  Downslope     10.536         31.829        235.205         0.5850      
   4.276  Peak End      -0.069          0.000         *****          *****       
   4.731  PeakStart     -0.076          0.191         *****          *****       
   4.915  Upslope       51.570         52.034        250.657         1.4131      
   4.977 Peak Apex      91.479         92.874        250.612         1.4131      
   5.050  Downslope     47.330         48.422        250.549         1.4120      
   5.603  PeakStart     -0.015          0.168         *****          *****       
   5.763  Upslope       11.416         35.615        255.623         0.5189      
   5.824 Peak Apex      22.410         68.912        255.721         0.5238      
   5.886  Downslope     13.735         41.612        255.850         0.5301      
 

General Table Report 
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 File:  c:\star\tutorial\pv_sam01.run Rpt Date:  28-JUN-94 7:04 PM
 Name:  Sample #1
 Sample #1 with the internal standard added at Instrument:  Varian LC Star
 9.5 ppm. Method:    TEST27.MTH
 Operator:  MEA
 Run Date:  22-SEP-88 12:30 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

Vertical lines indicate impurity.
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Peak Purity Survey:  200->367 nm.  PuP Interval +/- 0.50 nm.
Minimum Peak Height:  10.000 mAU.

Apex Purity Parameters (nm) Apex Purity Parameters (nm)
Time Front Apex Back Time Front Apex Back

200->367

   1.880 208.067 232.316 232.185
   3.428 223.089 228.963 234.327

  

Peak Purity Survey Report  
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 File:  c:\star\tutorial\pv_sam01.run           Rpt Date:  28-JUN-94 7:04 PM     
 Name:  Sample #1                                                                
 Sample #1 with the internal standard added at  Instrument:  Varian LC Star      
 9.5 ppm.                                       Method:    TEST27.MTH            
                                                Operator:  MEA                   
                                                Run Date:  22-SEP-88 12:30 PM    
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz                        
-------------------------------------------------------------------------------- 
 Multiple Purity Parameters Report - Page 1                                      
 Events between 0.000 and 5.984 minutes                                          
                     210->367 nm    190->249 nm    224->278 nm    273->367 nm    
                     MaxAbs  PuP    MaxAbs  PuP    MaxAbs  PuP    MaxAbs  PuP    
   Time    Event      mAU    nm      mAU    nm      mAU    nm      mAU    nm     
  ------ ----------   ---    --      ---    --      ---    --      ---    --     
   1.683  PeakStart   -0.5  *****    -0.7  *****    -0.7  *****    -0.5  *****   
   1.757  Upslope     14.1 214.959   20.5 201.139    5.7 229.157    0.5 274.429  
   1.782  FShoulder   25.6 257.948   29.2 208.509   17.1 246.030   10.3 315.668  
   1.843  Upslope     47.2 251.646  106.2 201.503   34.7 252.837   33.8 287.754  
   1.880 Peak Apex   123.1 252.339  286.1 201.034   91.0 253.951   91.4 287.136  
   1.917  Downslope   28.9 252.098   69.8 200.554   21.3 253.434   21.3 287.386  
   2.347  Peak End     0.0  *****     0.0  *****     0.0  *****     0.0  *****   
   2.458  PeakStart    0.2  *****     0.0  *****    -0.0  *****     0.2  *****   
   2.556  Upslope     11.3 254.189   14.0 205.660   11.3 261.903   10.6 278.280  
   2.605 Peak Apex    54.4 254.179   67.2 205.636   54.4 261.904   50.6 278.282  
   2.642  Downslope   13.3 254.161   16.5 205.688   13.3 261.901   12.4 278.276  
   2.716  PeakStart    0.3  *****     0.0  *****     0.0  *****     0.3  *****   
   2.789  Upslope     19.6 226.701   34.4 200.446    6.8 251.018    4.9 280.651  
   2.826 Peak Apex    54.5 226.714   96.7 200.401   19.1 251.019   13.7 280.666  
   2.875  Downslope   15.3 226.785   27.0 200.451    5.4 250.991    3.8 280.691  
   2.998  Peak End     0.0  *****     0.0  *****     0.0  *****     0.0  *****   
   3.232  PeakStart    0.3  *****    -0.0  *****    -0.0  *****     0.3  *****   
   3.379  Upslope    137.2 239.448  163.9 204.420   74.1 262.394   74.1 278.144  
   3.428 Peak Apex   248.9 245.592  304.1 204.503  168.6 262.374  167.2 278.169  
   3.477  Downslope  107.9 250.057  137.3 204.774   91.5 262.192   87.8 278.209  
   3.760  PeakStart    0.2  *****     0.0  *****     0.1  *****     0.2  *****   
   3.883  Upslope     54.9 218.595   62.2 204.496   22.4 238.209    5.9 282.686  
   3.932 Peak Apex   112.8 219.472  139.0 203.693   43.4 240.695   14.7 282.021  
   3.993  Downslope   49.6 220.278   66.0 202.968   18.1 242.663    7.4 281.657  
   4.276  Peak End     0.0  *****     0.0  *****     0.0  *****     0.0  *****   
   4.731  PeakStart    0.2  *****     0.0  *****     0.0  *****     0.2  *****   
   4.915  Upslope     59.9 238.663   59.9 219.445   52.0 245.820   10.5 335.613  
   4.977 Peak Apex   106.7 238.632  106.7 219.419   92.9 245.760   18.6 335.538  
   5.050  Downslope   55.5 238.605   55.5 219.346   48.4 245.689    9.6 335.377  
   5.603  PeakStart    0.2  *****     0.1  *****     0.1  *****     0.2  *****   
   5.763  Upslope     77.3 230.226   80.0 207.025   29.9 259.177   29.9 278.869  
   5.824 Peak Apex   150.6 230.303  156.5 206.944   58.3 259.235   58.3 278.830  
   5.886  Downslope   91.5 230.423   95.5 206.837   35.6 259.310   35.6 278.796  

 
Multiple Purity Parameters Report  
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 File:  c:\star\tutorial\pv_sam01.run           Rpt Date:  28-JUN-94 7:04 PM     
 Name:  Sample #1                                                                
 Sample #1 with the internal standard added at  Instrument:  Varian LC Star      
 9.5 ppm.                                       Method:    TEST27.MTH            
                                                Operator:  MEA                   
                                                Run Date:  22-SEP-88 12:30 PM    
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz                        
-------------------------------------------------------------------------------- 
 Library Search Report (report best 5 matches or no match) - Page 1              
 Search Parameters: PuP Interval: +/-5.00 nm, Wavelength Range: 200->367 nm      
          Data File Time Range:  2.199 - 4.497 min.                              
          Library Relative Time Range:  0.000 - 1000.000                         
          Minimum Peak Height:  0.000 mAU,  Maximum Dissimilarity:  0.30         
 Libraries:                                                                      
 A: c:\star\tutorial\pv_std01.lbr                                                
-------------------------------------------------------------------------------- 
                                                                                 
 Target Spectrum: Peak Apex, PuP(nm): 240.714, tR(min): 2.605                    
                  Peak Height: 67.218 mAU at 200 nm                              
 No Matches                                                                      
                                                                                 
 Target Spectrum: Peak Apex, PuP(nm): 215.179, tR(min): 2.826                    
                  Peak Height: 68.307 mAU at 200 nm                              
 Possible Matches:                 Sim.    Dissim.  PuP(nm)   tR(min)  Lib  #    
 -----------------                -------  -------  -------   -------  ---  -    
 Dimonreal                        1.00000  0.00220  215.211     2.825   A   2    
 AS-98                            0.96376  0.26677  219.558     3.430   A   3    
 AS-96                            0.96203  0.27293  219.509     5.848   A   6    
                                                                                 
 Target Spectrum: Peak Apex, PuP(nm): 228.963, tR(min): 3.428                    
                  Peak Height: 304.074 mAU at 205 nm                             
 No Matches                                                                      
                                                                                 
 Target Spectrum: Peak Apex, PuP(nm): 212.576, tR(min): 3.932                    
                  Peak Height: 115.909 mAU at 200 nm                             
 Possible Matches:                 Sim.    Dissim.  PuP(nm)   tR(min)  Lib  #    
 -----------------                -------  -------  -------   -------  ---  -    
 AH-187                           0.98600  0.16676  212.096     3.948   A   4    
 Dimonreal                        0.97866  0.20550  215.211     2.825   A   2    

 

Library Search Report (Long Text Format)  



APPENDIX B  
NON-INTERACTIVE REPORTS 

PolyView2000TM 139 

 File:  c:\star\tutorial\pv_sam01.run           Rpt Date:  28-JUN-94 7:04 PM     
 Name:  Sample #1                                                                
 Sample #1 with the internal standard added at  Instrument:  Varian LC Star      
 9.5 ppm.                                       Method:    TEST27.MTH            
                                                Operator:  MEA                   
                                                Run Date:  22-SEP-88 12:30 PM    
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz                        
-------------------------------------------------------------------------------- 
 Library Search Report (report best match or no match) - Page 1                  
 Search Parameters: PuP Interval: +/-5.00 nm, Wavelength Range: 200->367 nm      
          Data File Time Range:  2.199 - 4.497 min.                              
          Library Relative Time Range:  0.000 - 1000.000                         
          Minimum Peak Height:  0.000 mAU,  Maximum Dissimilarity:  0.30         
 Libraries:                                                                      
 A: c:\star\tutorial\pv_std01.lbr                                                
-------------------------------------------------------------------------------- 
 Target            Best Possible                                          Entry  
 Apex(min)             Match                Sim.    Dissim.  tR(min)  Lib   #    
 ---------             -----               -------  -------  -------  ---   -    
    2.605  No Match                                                              
    2.826  Dimonreal                       1.00000  0.00220    2.825   A    2    
    3.428  No Match                                                              
    3.932  AH-187                          0.98600  0.16676    3.948   A    4    

 

Library Search Report (Short Text Format) 
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 File:  c:\star\tutorial\pv_sam01.run Rpt Date:  28-JUN-94 7:04 PM
 Name:  Sample #1
 Sample #1 with the internal standard added at Instrument:  Varian LC Star
 9.5 ppm. Method:    TEST27.MTH
 Operator:  MEA
 Run Date:  22-SEP-88 12:30 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

 Library Search Report (report best 5 matches or no match) - Page 2
 Search Parameters: PuP Interval: +/-5.00 nm, Wavelength Range: 200->367 nm
          Data File Time Range:  2.199 - 4.497 min.
          Library Relative Time Range:  0.000 - 1000.000
          Minimum Peak Height:  0.000 mAU,  Maximum Dissimilarity:  0.30
 Libraries:
 A: c:\star\tutorial\pv_std01.lbr                                             

Target Spectrum:
Peak Apex,  tR:  2.826 min,  PuP:  215.179 nm
Peak Height:  68.307 mAU at 200 nm

Possible Match:  (Library:  A,  # 2)
Dimonreal
Note:  Internal standard peak at 9.5 ppm.
Similarity   Dissimilarity   PuP(nm)   tR(min)
 1.00000        0.00220      215.211     2.825

Possible Match:  (Library:  A,  # 3)
AS-98
Note:  Test fraction @ 10.0 ppm
Similarity   Dissimilarity   PuP(nm)   tR(min)
 0.96376        0.26677      219.558     3.430

Possible Match:  (Library:  A,  # 6)
AS-96
Note:  Test fraction @ 10.0 ppm.
Similarity   Dissimilarity   PuP(nm)   tR(min)
 0.96203        0.27293      219.509     5.848

                    

Library Search Report  (Long Graphics Format) 



APPENDIX B  
NON-INTERACTIVE REPORTS 

PolyView2000TM 141 

 File:  c:\star\tutorial\pv_sam01.run Rpt Date:  28-JUN-94 7:04 PM
 Name:  Sample #1
 Sample #1 with the internal standard added at Instrument:  Varian LC Star
 9.5 ppm. Method:    TEST27.MTH
 Operator:  MEA
 Run Date:  22-SEP-88 12:30 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

 Library Search Report (report best match or no match) - Page 1
 Search Parameters: PuP Interval: +/-5.00 nm, Wavelength Range: 200->367 nm
          Data File Time Range:  2.199 - 4.497 min.
          Library Relative Time Range:  0.000 - 1000.000
          Minimum Peak Height:  0.000 mAU,  Maximum Dissimilarity:  0.30
 Libraries:
 A: c:\star\tutorial\pv_std01.lbr                                             

Peak Apex,  tR:  2.605 min,  PuP:  240.714 nm
Peak Height:  67.218 mAU at 200 nm

No Match

Peak Apex,  tR:  2.826 min,  PuP:  215.179 nm
Peak Height:  68.307 mAU at 200 nm

Possible Match:  (Library:  A,  # 2)
Dimonreal
Note:  Internal standard peak at 9.5 ppm.
Similarity   Dissimilarity   PuP(nm)   tR(min)
 1.00000        0.00220      215.211     2.825

Peak Apex,  tR:  3.428 min,  PuP:  228.963 nm
Peak Height:  304.074 mAU at 205 nm

No Match

Peak Apex,  tR:  3.932 min,  PuP:  212.576 nm
Peak Height:  115.909 mAU at 200 nm

Possible Match:  (Library:  A,  # 4)
AH-187
Note:  Test fraction @ 10.0 ppm
Similarity   Dissimilarity   PuP(nm)   tR(min)
 0.98600        0.16676      212.096     3.948

                    

Library Search Report (Short Graphics Format)  
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 File:  c:\star\tutorial\pv_sam01.run Rpt Date:  28-JUN-94 7:04 PM
 Name:  Sample #1
 Sample #1 with the internal standard added at Instrument:  Varian LC Star
 9.5 ppm. Method:    TEST27.MTH
 Operator:  MEA
 Run Date:  22-SEP-88 12:30 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

Absorbance Average:  200->367 nm
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Purity Parameter:  200->367 nm  (Peak Heart)
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Double Plot Report (Example 1) 
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 File:  c:\star\tutorial\pv_sam01.run Rpt Date:  28-JUN-94 7:04 PM
 Name:  Sample #1
 Sample #1 with the internal standard added at Instrument:  Varian LC Star
 9.5 ppm. Method:    TEST27.MTH
 Operator:  MEA
 Run Date:  22-SEP-88 12:30 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

Maximum Absorbance:  200->367 nm
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Wavelength of Maximum Absorbance:  200->367 nm  (Peak Heart)

1 2 3 4 5
minutes

200.0

202.5

205.0

207.5

210.0

nm

                       

Double Plot Report (Example 2) 
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 File:  c:\star\tutorial\dipa_is.run Rpt Date:  28-JUN-94 7:10 PM
 Name:  0.01Diquat/0.1Paraquat
 Same as DIPA3053.RUN, but added Instrument:  Varian Star
 DiMethylPhtalate peak at 1.2 minutes as Method:    pq.mth
 Internal Standard Operator:  Number 1
 Run Date:  3-MAR-92 10:40 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

MCA Report - External Standard Analysis

Baseline:  1.794 min (average of 5) to 3.563 min (average of 5)
Integration:  1.794 to 3.563 min,  Flow Rate:  2.000 ml/min (Pump Log)
Library:  c:\star\tutorial\dipa_is.lbr

Spectrum Analysis over 239-367 nm
excluding 335-367
Lib Name Amount
Index

#1 Paraquat 9.90 ug
#2 Diquat 0.88 ug

Similarity: 1.00000
Dissimilarity: 0.00074 (0.001303)

Search window: 1.828 to 2.743 min
Spectra in library: 3
Spectra in search window: 2
Components allowed: 6
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Plot Analysis at 283 nm

Lib tR Height Width Res
Index (min) mAU (sec)

#2 2.014 2.94 8.8 ---
#1 2.286 59.62 12.6 0.90

Error Analysis over 239 - 367 nm

The maximum error 30 uAU
at 2.291 minutes DOES NOT EXCEED
the noise threshold 80 uAU.
The ratio of maximum to expected
error is 0.356.

                                                                                 

Multicomponent Analysis Report (External Standard) 
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 File:  c:\star\tutorial\dipa_is.run Rpt Date:  28-JUN-94 7:10 PM
 Name:  0.01Diquat/0.1Paraquat
 Same as DIPA3053.RUN, but added Instrument:  Varian Star
 DiMethylPhtalate peak at 1.2 minutes as Method:    pq.mth
 Internal Standard Operator:  Number 1
 Run Date:  3-MAR-92 10:40 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

MCA Report - Internal Standard Calibration

Baseline:  1.020 min (average of 5) to 1.376 min (average of 5)
Integration:  1.020 to 1.376 min,  Flow Rate:  2.000 ml/min (Pump Log)
Library:  c:\star\tutorial\dipa_is.lbr

Spectrum Analysis over 239-367 nm
excluding 292-367
Lib Name Amount
Index

#3 Caffeine - IS 1.01 ug

Expected IS Amount: 1.000000 #3
IS Correction Factor: 1.005416

Similarity: 1.00000
Dissimilarity: 0.00048 (0.002723)

Search window: 0.963 to 1.445 min
Spectra in library: 3
Spectra in search window: 1
Components allowed: 1
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Plot Analysis at 283 nm

Lib tR Height Width Res
Index (min) mAU (sec)

#3 1.200 19.77 5.7 ---

Error Analysis over 239 - 367 nm

The maximum error 20 uAU
at 1.154 minutes DOES NOT EXCEED
the noise threshold 80 uAU.
The ratio of maximum to expected
error is 0.269.

 

Multicomponent Analysis Report (Internal Standard Calibration) 
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 File:  c:\star\tutorial\dipa_is.run Rpt Date:  28-JUN-94 7:10 PM
 Name:  0.01Diquat/0.1Paraquat
 Same as DIPA3053.RUN, but added Instrument:  Varian Star
 DiMethylPhtalate peak at 1.2 minutes as Method:    pq.mth
 Internal Standard Operator:  Number 1
 Run Date:  3-MAR-92 10:40 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

MCA Report - Internal Standard Analysis

Baseline:  1.794 min (average of 5) to 3.563 min (average of 5)
Integration:  1.794 to 3.563 min,  Flow Rate:  2.000 ml/min (Pump Log)
Library:  c:\star\tutorial\dipa_is.lbr

Spectrum Analysis over 239-367 nm
excluding 335-367
Lib Name Amount
Index

#1 Paraquat 9.84 ug
#2 Diquat 0.87 ug

IS Correction Factor: 1.005416

Similarity: 1.00000
Dissimilarity: 0.00074 (0.001303)

Search window: 1.828 to 2.743 min
Spectra in library: 3
Spectra in search window: 2
Components allowed: 6

200 225 250 275 300 325
Wavelength (nm)

0.25

0.50

0.75

1.00

1.25

1.50

AU.s239 367

-1.5
-1.0
-0.5
0.0
0.5
mAU.s239 367

0

10

20

30

40

50

mAU

2.00 2.50 3.00
minutes

10

30

50

uAU

Plot Analysis at 283 nm

Lib tR Height Width Res
Index (min) mAU (sec)

#2 2.014 2.94 8.8 ---
#1 2.286 59.62 12.6 0.90

Error Analysis over 239 - 367 nm

The maximum error 30 uAU
at 2.291 minutes DOES NOT EXCEED
the noise threshold 80 uAU.
The ratio of maximum to expected
error is 0.356.

 

Multicomponent Analysis Report (Internal Standard Analysis) 
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 File:  c:\star\tutorial\dipa_is.run Rpt Date:  28-JUN-94 7:10 PM
 Name:  0.01Diquat/0.1Paraquat
 Same as DIPA3053.RUN, but added Instrument:  Varian Star
 DiMethylPhtalate peak at 1.2 minutes as Method:    pq.mth
 Internal Standard Operator:  Number 1
 Run Date:  3-MAR-92 10:40 PM
 Scan Rate:  10.851 Hz   Bunch:  8   Data Rate:  1.356 Hz

Purity Analysis Report

Baseline:  1.794 min (average of 5) to 3.563 min (average of 5)
Integration:  1.794 to 3.563 min
Reference Spectrum:  Region above 50.00% of Apex, 2.175 to 2.396 min

Spectrum Analysis over 220-367 nm
excluding 325-367

Reference vs. Whole Area Spectrum
Similarity: 1.00000
Dissimilarity: 0.00000

200 225 250 275 300 325
Wavelength (nm)

0.00

0.25

0.50

0.75

1.00

AU.s220 367

0

25

50

75

100

mAU

2.00 2.50 3.00
minutes

1
2
3
4

mAU

Plot Analysis at 254 nm

tR Height Width
(min) mAU (sec)
2.286 116.39 12.6

Error Analysis over 220 - 367 nm

The maximum error 6 mAU
at 2.012 minutes EXCEEDS
the noise threshold 0.08 mAU.
The ratio of maximum to expected
error is 69.061.

 

Purity Analysis Report 
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